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1 Introduction 

Course Prerequisites 
This training course is intended for ODOT Survey personnel directly involved in the acquisition and 
processing of field collected survey data. This course is intended as an overview of survey data 
processing and is not a comprehensive reference guide. For additional information regarding specific 
software functions please refer to Bentley’s online help information. 
 
It is recommended that students meet the following prerequisites: 
 

 Familiarity with ODOT’s design policies, procedures, and CADD Standards 
 Data collection and survey processing experience 
 A working knowledge of Windows 7 
 A working knowledge of MicroStation V8i 

 

CPD Credit 
Participants in the class are eligible for CPD credit*.  A certificate for CPD credit is available upon request 
from the instructor at the completion of this course. 
 
*Please note that final determination on what qualifies for CPD credit ultimately lies between the 
license holder and the State Board for Professional Engineers and Surveyors. 
 

Course Outline 
During this training course we will use Bentley’s OpenRoads Survey product to process survey data using 
a variety of datasets provided by ODOT personnel. The following topics are covered in the class: 
 

 An overview of the Bentley OpenRoads Survey software 
 Field Codes and Point Element Names 
 ODOT CADD Standards for Survey 
 Annotation Scale 
 Working with 3D MicroStation Files 
 Importing Survey data from various sources 
 Geographic Coordinate Systems 
 Correcting Code Errors 
 Graphic Linear Features 
 Bridge Surveys 
 Ground Survey and LiDAR Data 
 Linear Crossings 
 Exporting Data for GEOPAK SS2 Users 

 
The training data for this course uses several different datasets that are separate examples of various 
Survey processing options and tools. The use of separate datasets also helps illustrate ODOT’s use of 
MicroStation Project Configuration files. 
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Course Schedule 

 

Start Time: 8:00 AM 
End Time: 3:00 PM 

 

Breaks: 15 Minutes per half day 

 
Lunch: 30 Minutes 

 

Web Browsing: Please limit web browsing to break times and lunch. 

 

Email: Please limit email usage to break times and lunch. 

 

Cell Phones: Please set cell phones to vibrate and take calls only at break times and lunch 
unless absolutely necessary. Please refrain from texting during the class 

 

CADD Standards and Support 
ODOT CADD Standards for MicroStation, GEOPAK, and OpenRoads are maintained and distributed by 

the ODOT Office of CADD and Mapping Services. 

http://www.dot.state.oh.us/Divisions/Engineering/CaddMapping/CADD_Services/Pages/default.aspx 

The ODOT CADD Engineering Standards manual is available in Adobe Acrobat PDF format on the ODOT 

Website: 

http://www.dot.state.oh.us/Divisions/Engineering/CaddMapping/CADD_Services/Standards/Pages/Manuals.aspx 

OOOT’s Design Resource Reference Center is a centralized online reference center to help locate online 

or printed material. Additionally, several mailing lists are available to keep you informed about updates 

to ODOT standards. Visit the Design Resource Reference Center at the following URL: 

http://www.dot.state.oh.us/drrc/Pages/default.aspx 

Support for Bentley OpenRoads Survey is the responsibility of the Office of CADD and Mapping Services. 

Support questions can be sent to the CADD Support staff using the following form: 

http://www.dot.state.oh.us/Divisions/Engineering/CaddMapping/CADD_Services/Support/Pages/ServiceRequest.aspx 

This version of the training guide has been updated to use the new ODOT CADD Standards configuration 
for MicroStation/GEOPAK SS3 using the “ODOTcadd” folder structure. The CADD standards are installed 
to the following folder for a normal ODOT installation: 
 

I:\ODOTcadd\Standards 
 

http://www.dot.state.oh.us/Divisions/Engineering/CaddMapping/CADD_Services/Pages/default.aspx
http://www.dot.state.oh.us/Divisions/Engineering/CaddMapping/CADD_Services/Standards/Pages/Manuals.aspx
http://www.dot.state.oh.us/drrc/Pages/default.aspx
http://www.dot.state.oh.us/Divisions/Engineering/CaddMapping/CADD_Services/Support/Pages/ServiceRequest.aspx
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2 OpenRoads Survey Overview 

What is OpenRoads? 
You may have heard of Bentley’s “OpenRoads” technology and the Select Series 3 release of 
MicroStation and Bentley Civil products. But exactly what is OpenRoads? 
 
OpenRoads is described as follows on the Bentley Website: 
 
“OpenRoads technology represents the continued evolution of merging functionality for Bentley’s road 
design, drainage analysis and design, data input and reduction, and bridge modeling products. This 
shared technology is embedded in InRoads, GEOPAK, MXROAD, and PowerCivil. It expands these 
products to include information-rich 3D modeling integrated with CAD, mapping, GIS, and business tools 
like PDFs, i-models, and hypermodels.” 
 
“OpenRoads technology provides the common workflow, data structure, and modeling tools that civil 
engineering organizations need to meet today’s information modeling and accelerated project delivery 
requirements.” 
 
But what does this mean for ODOT’s GEOPAK Road and GEOPAK Survey users? It means that a new 
generation of Bentley Civil products is upon us that will eventually supersede Bentley’s current civil 
products InRoads, GEOPAK and MXROAD. 
 

How does OpenRoads Survey differ from GEOPAK Survey? 
There are several key differences between OpenRoads Survey and GEOPAK Survey. Some of these 
differences are summarized below. 
 

 Unlike GEOPAK Survey, all OpenRoads data is stored in a MicroStation design file 
o The GPK file is no longer used to store survey points and survey chains 
o The Terrain Model is stored directly in the DGN file 
o OpenRoads Survey no longer generates all the external text files and reports that were 

automatically generated by GEOPAK Survey 
o OpenRoads Survey information must be exported from the design file to GEOPAK GPK 

and TIN files if the designer will be using GEOPAK Road for the project. This export is not 
necessary for designers using the OpenRoads Civil tools. 

 
 3D MicroStation Design Models are required for OpenRoads survey processing 

o Some tools within OpenRoads Survey require a 3D Model to operate as expected 
 

 The GEOPAK SMD file is not used directly to define the field codes 
o Field codes are stored in a DGN Library that references the SMD file 

 
 Survey mapping is generated using the MicroStation Annotation Scale functionality 
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 MicroStation is opened using a desktop shortcut to open MicroStation using either the legacy 
ODOTv8i CADD Standards or the new ODOTcadd Standards. Users must use the MicroStation 
Manager dialog to open design files in order to ensure that the correct User Configuration file 
(UCF) and Project Configuration file (PCF) are selected. It is no longer acceptable to open 
MicroStation files by double-clicking on the file name in Windows Explorer. 

 
 Default project settings for OpenRoads Survey are now stored in DGN Libraries that are included 

in the ODOTcadd workspace configuration. 
 

 Geographic Coordinate Systems (GCS) can be defined to establish the coordinate system for the 
data which allows easy translation between grid and ground coordinates 

 
 Changes to the Survey graphics are dynamic and automatically update the Terrain Model. 

 
 The user interface has changed. OpenRoads Survey tools are built into the MicroStation Tasks 

menu and are no longer accessed through the Applications > GEOPAK pull-down menu 
 

 Undo. If you make a mistake while editing survey data, just click the MicroStation Undo 
command.  It’s that simple! 

 

OpenRoads Survey Online Help 
The help file for OpenRoads Survey is accessed From the MicroStation Tasks menu by selecting Tasks > 
Civil Tools > OpenRoads Help. To access the OpenRoads Survey help information, the Survey Toolset 
item. 
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The ODOT Workspace 
A Workspace is a custom MicroStation environment or configuration. By selecting a workspace, you are 
customizing MicroStation and the Civil products for a specific discipline, project, or task. The workspace 
contains pointers to the CADD standards, DGN libraries, cell libraries, seed files, symbology resources, 
etc. necessary for the project. 
 
ODOT’s Standard configuration provides two workspaces for MicroStation and GEOPAK projects. These 
workspaces are selected by choosing the appropriate item from the Windows Start Menu as shown 
below. 

 
The workspaces are configured to access 
MicroStation/PowerGEOPAK with either the legacy V8istd 
CADD Standards or the new ODOTcadd Standards. 
 
Care must be taken to select the appropriate item for the 
project that you intend to open to ensure that the correct 
CADD standards are accessed. 
 
When the ODOTcadd PowerGEOPAK SS4 item is selected, 
the MicroStation File Open dialog shown below is opened. 
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User Configuration 
The User option is used to select the MicroStation user configuration file (.ucf).  When MicroStation is 
opened the User option will default to ODOTcadd as shown above.  
 
Project Configuration 
With MicroStation and PowerGEOPAK V8i (SELECTseries 4), ODOT will transition to using a MicroStation 
project configuration (.pcf) file for each project that has been assigned a PID number. The PCF file is 
used to define project specific MicroStation variables. The Project menu will contain a list of the 
available projects. When a project is selected from the list, the File Open dialog will default to the root 
folder that has been defined for the project. 
 
Important! 
Many users are in the habit of opening MicroStation files by double-clicking the file name in Windows 
Explorer. When a MicroStation file is opened in this fashion, the User and Project configuration files that 
were active the last time MicroStation was opened will be used. In order to ensure that the correct 
configuration files are selected for OpenRoads projects, users should get in the habit of opening 
MicroStation from the program shortcut in order to select the appropriate User and Project 
configuration files before prior to opening MicroStation design files. 
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Exercise 1 - Training File Installation 
The training files for this class can be installed from the ODOT CADD Standards folder by use of a custom 

application. To install the training files, run the following program: 

I:\ODOTcadd\Standards\ODOT\Training\ODOTcadd_ConfigureTraining.exe 

The program can also be accessed from the ODOTcadd program group in the Windows Start Menu by 

selecting All Programs > ODOTcadd > Utilities > ODOTcadd_ConfigureTraining. 

The application will prompt you to close MicroStation if it is running. Select OK to proceed. 

 
The program must access ODOT’s CADD Standards for PowerGEOPAK V8i (SELECTseries 4) in order to 

install the training files. These standards are housed in the “ODOTcadd” folder. The program will search 

for the “ODOTcadd” folder in the following location: 

I:\ODOTcadd 

If the program cannot find the ODOTcadd folder in 

the location specified above, the Browse for Folder 

dialog shown at right is opened. 

Browse to the ODOTcadd folder and then choose the 

Ok button as shown at right. 

After the ODOTcadd folder has been successfully 

identified, the dialog shown on the following page is 

opened. 
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The dialog has the following functions: 

Training Class 

Choose the OpenRoads Survey option as shown above 

Installation Folder 

The default location for the training files is set to C:\ODOT_Training as shown above. This 

location can be changed, however if the location is changed is will be necessary to manually edit 

the Target for the MicroStation shortcut that is created when the training files are installed. See 

Editing the Training Shortcut on the following page for more information. 

If you change the installation folder, the selected folder will automatically be appended with the 

“\ODOT_Training” folder name. For example, selecting the path W:\myFiles will result in an 

installation folder of W:\myFiles\ODOT_Training. 

Install Files 

Select the Install Files button to begin the installation process. 

Upon completion, you will be notified as shown below. If a previous installation of the training 

files exists on the computer, you will be prompted to remove the old files. 
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For this training, be sure to open PowerGEOPAK using the shortcut included in the training folder shown 
below. 

 
Important! 
This shortcut should be used for training only. When working on ODOT projects, be sure to open 
MicroStation using the appropriate shortcut from the Windows Start Menu. 

 
Editing the Training Shortcut 
If you elect to install the training files to a location 

other than the default, the shortcut that is used to 

open MicroStation for the training must be manually 

edited to target the correct path for the training 

configuration. Take the following steps to edit the 

shortcut: 

 Right-click on the shortcut icon and then 
select the Properties option to open the 
dialog shown at right.  
 
The Target for the shortcut includes 
information to launch MicroStation as well 
as a workspace switch (defined by the –wc 
syntax) to tell MicroStation which 
configuration file to load when the program 
is launched. 
 
The default value for this switch is set as 
follows in the shortcut: 
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-wcC:\ODOT_Training\OpenRoadsSurvey\workspace\ODOT_OpenRoadsSurvey.cfg 

If you have elected to install the training files to a location other than the default, the path for 

the workspace switch must be manually edited to identify the path where you have installed the 

training files. 

For example, if the installation folder was changed to W:\myFiles\ODOT_Training, the –wc 

switch would be edited as follows: 

-wcW:\myFiles\ODOT_Training\OpenRoadsSurvey\workspace\ODOT_OpenRoadsSurvey.cfg 

IMPORTANT! 

Be careful not to delete or edit anything else in the Target field. Also be careful to retain the 

path to the configuration file from the ODOT_Training folder onwards. 

Double-click the training shortcut to launch MicroStation for the training environment. The File Open 

dialog is opened as shown below.

 

User Configuration 
The User option is used to select the MicroStation user configuration file (.ucf).  When MicroStation is 
opened using the training shortcut, the User option will default to ODOTcadd as shown above.  
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Project Configuration 
The training data for this class uses MicroStation project configuration files (.pcf). By default, these files 
are located in the following folder for the training class: 
 

C:\ODOT_Training\OpenRoadsSurvey\ProjectPCF 
 

The PCF files define project specific MicroStation configuration variables. Each dataset for the training 
has a unique PCF file that is selected from the File Open dialog before accessing the project data, as 
shown below. 
 

 
 
 
When a Project is selected from the list, the File Open dialog will automatically change to the parent 
folder for the selected project. 
 
After installing the training files, take the following steps to open an example Survey project that has 
already been processed: 
 

 Select the Project configuration file JAC-98167 as shown above. 
 
The File Open dialog will automatically change to the PID number folder for the project 
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 Open the following design file: 
 

\Design\Survey\RawData\98167_FB001.dgn 
 
When the file is opened, the interface should appear similar to the example shown below. 

 
The Task Navigation, Element Information, and Project Explorer dialogs are docked and unpinned to the 
left of the screen. Each of these dialogs are used for Survey processing and are defined on the following 
pages. 
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Task Navigation Menu 
By default, the Task Navigation menu is docked and unpinned on the left side of the screen as shown in 
the example on the previous page. When you float the cursor over the Tasks tab, the Tasks menu will 
expand as shown below. 

 
The Tasks dialog can be configured as free 
floating or docked. 
 
Once docked, the dialogs can be “pinned” or 
“unpinned”.  An “unpinned” dialog will 
automatically open when the user floats the 
cursor over the dialog. 
 
To pin or unpin a docked dialog, select the 
push-pin icon on the right side of the dialog 

title bar.  
 
 
 
 
 
 
 
 
 
 
 
 

 
 
The Tasks menu is used to select commands. The Survey tools can be accessed by selecting Civil Tools > 
Survey from the Tasks menu as shown above. 

 
 If the Task Navigation menu is not shown, it can be configured by selecting Workspace > 

Preferences to access the Preferences dialog shown below. Set the Task Navigation > 
Presentation option to Dialog. 
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Project Explorer Dialog 
The Project Explorer dialog is used extensively with OpenRoads. By default this dialog is docked and 
unpinned on the left side of the screen as shown on page 12. 
 

 If the Project Explorer dialog is not shown, the dialog can be opened by selecting File > 
Project Explorer from the MicroStation pull-down menu. 

 
The Project Explorer dialog contains several tabs which can be toggled on or off in the project explorer 
settings. To review the settings, select Settings > Project Explorer from the MicroStation pull-down 
menu to open the Project Explorer Settings dialog shown at right below. 
 
Recommended settings: 
 

Browsers 
Set all of the available options to True. 
 
Dialog Properties 
The Browse Layout option is set to Group Panel 
by default. 

 
 
 
 
 
 
 
 
 
Once configured, the Project Explorer dialog should 
appear similar to the example shown at right. 
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The Project Explorer Survey Group 

The Survey group in Project Explorer is used to view information about any survey content contained in 
the active Model. 
 
Expand the Survey group by clicking on the Survey heading. The group opens to reveal a tree of 
information as shown below. 

 
The active MicroStation Model is listed at the top of 
the tree; “Design” in the example at left. 
 
Beneath that is a list of any Field Books in the file. A 
Field Book can contain one or more survey Data Sets. 
Each data set in the field book is used to generate 
mapping and a terrain model for that field book. This 
example contains two separate field books; one for 
the topo survey, and one for the bridge deck survey.  
 
In this example, each field book contains one data 
files that has already been imported. Expanding the 
Topo item reveals any Data Files, and information 
about each data file that has been imported into the 
Topo field book. 
 
 
 

 
The Topo field book has one Data File named JAC321685TOPO.dc as 
shown at right. 
 
Expanding the Point Features or Linear Features items will reveal a list 
of the point and linear field codes that are used in the data set. 
 
The display of each item can be turned on/off by use of the check box 
to the left of the item. 
 
In this example each data set was imported in a separate field book so 
that a separate terrain model could be made for each data set. The 
bridge deck data is not included in the topo terrain model, and vice 
versa. A rotated view of the data is shown on the following page. The 
terrain model for the bridge deck is shown in gray. 
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More information about creating field books and data sets can be found on page 23. 
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Survey Details Dialog 
In addition to the Task Navigation menu and the Project Explorer dialog, the Survey Details dialog is 
frequently used to display details for the currently selected survey point, line, or terrain model.  
 

 The Survey Details dialog is not shown by default in the ODOTcadd workspace. The dialog 
can be opened by selecting the Show Details icon in the Survey Processing task group as 
shown below. 

 
The Survey Details dialog consists of two tabs as shown below. The Element List displays 
the currently selected survey information and can also be used for editing the data. The 
Message Center displays any warnings or error messages.  
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Using the Project Explorer and Survey Details Dialogs 

The Project Explorer and Survey Details dialogs are used extensively with OpenRoads Survey. 
 
Project Explorer is used for several tasks, including the following: 

 Importing survey data into one or multiple Field Books 
 Reviewing the contents of a survey dataset 
 Reviewing and editing the Project Settings 
 Exporting data to other formats (GPK, TIN, LandXML, etc.) 
 Selecting the information that is displayed in the Survey Details dialog 

 
When the Survey tab is selected, the Project Explorer dialog 
is used to display the information for the survey project 
similar to the example at right. 
 
When populated with data, the data tree contains one or 
more branches. Each branch is accompanied by a checkbox 
that enables/disables the visualization of the branch and 
sub-branches. 
 
Field Books – Expands to show all of the survey data loaded 
into the project. The example at right contains two field 
books: “Bridge Deck” and “Topo” 
 
Data Files – Expands to show all of the survey data files currently loaded into the project. Each data file 
expands to show additional branches for Point Features, Linear Features, Control Points, Setups, and 
Observations. 
 
Point Features – Lists points loaded from a survey data file. The Point Features branch expands to show 
a list of individual feature names. Selecting one of the feature names will display all the points that use 
the selected feature definition in the Survey Details dialog. 
 
Linear Features – Lists linear features loaded from a survey data file. The Linear Features branch 
expands to show a list of individual feature names. Selecting one of the feature names will display all the 
linear features that use the selected feature definition in the Survey Details dialog. 
 
Control Points – Lists the control points that exist in the selected data file. The list of control points is 
displayed in the Survey Details dialog. 
 
Setups – Shows all setups contained in the data file. 
 
Observations - Shows all observations contained in the data file. 
 
Adjustment – When activated, a Least Squares Adjustment is applied to the entire field book. To 
activate the adjustment, right-click on “Adjustment” and select Turn On. The circular symbol to the right 
of the Adjustment branch will become green when the adjustment option has been enabled. The check 
box toggles the graphical display of the error ellipses resulting from the adjustment. When active, the 
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least squares adjustment properties are shown in the Detail Panel. Caution: Once enabled, the adjusted 
data cannot be “unadjusted”. 
 
Filters - The Filters branch allows you to create customized data filters for quick viewing of data sub-
sets. 
 
Features for the entire field book can be reviewed in the Survey Details dialog by selecting one of the 
ALL Point Features, ALL Linear Features, ALL Control Points, or ALL Observations items. Once an item is 
selected, the details for the item are displayed in the Survey Details dialog as shown below. 

 
In the example above, the ALL Point Features item was selected for the Bridge Deck field book. 
 

 The Element List tab displays all the features for the selected field book. 
 

 The Message Center displays any warnings of error messages for the selected Field Book. 
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Survey Processing Workflow 
All survey data processed using the Bentley Survey tools is stored directly in the active MicroStation 
design file.  No external databases are used to store the survey data or the existing ground terrain 
model.  One sample workflow is depicted below (specific workflows may vary): 
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Create a new Field Book 

Field Books are used to store one or more datasets. For a most ODOT projects, all of the datasets will be 
imported into a single field book. There are cases where you may want to consider using multiple field 
books. 
 
Single Field Book 

 A field book can contain multiple data sets 
 If duplicate point names are encountered while importing multiple data sets into a field book, 

the software will allow you to modify the point names during the import process 
 You can create linear features that span multiple datasets 
 All of the datasets within the field book are used to generate the terrain model 

 
Multiple Field Books 

 Use multiple field books if your project has two or more sections that are geographically 
disconnected from each other. 

 Each field book has unique point names so the same point name can exist in each field book. 
 Linear Features can only contain points between datasets in the same field book. It is not 

possible to create linear features that cross from one field book to another. 
 Separate Terrain models can be generated for each field book. These terrain models are used wi 

the OpenRoads tools or can be exported for use with GEOPAK, InRoads, or MXROADS. 
 
To create a new field book, right-click on the Field Books branch of the data tree in the Survey tab of the 
Project Explorer dialog and then click the New… option on the menu. 
 

 
  
A new field book named “Field Book 1” is created. 
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To change the name of a field book, right-click the field book in the data tree and select the Properties 
option to open the Element Information dialog shown below.  

 
The name can be edited in the Element Information dialog. 
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Add Survey Data 

If you wish to add survey data, simply drag the appropriate file from Windows Explorer and drop it onto 
the data tree. Or choose one of the Load options shown below. 

 
Several file types are supported by OpenRoads Survey as shown below. 
 

 
 
After selecting the file to load, the software performs the following actions: 

 Processes the data to produce point features and linear features 
 If the Adjustment option has been enabled, then the Least Squares Adjustment is applied 
 Point and Linear Features are symbolized according to the ODOT Feature Definitions 
 Point and Linear Features, Setup, and Observation data are stored in the active design file 
 A terrain model named “All Field Books” is produced using the points and lines from the data 
 The terrain model is stored in the active design file 
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Exercise 2 – Survey Processing Example 
In this exercise we will process a sample data set in order to get familiar with the OpenRoads Survey 
workflow. 
 

 Start MicroStation by using the shortcut for the training class. By default, the shortcut is located 
in the c:\ODOT_Training folder as shown below when the training files are installed. If you have 
installed the training files to a different location, browse to that location to access the shortcut. 

 
 The MicroStation File Open dialog is opened. The User will default to ODOTcadd as shown 

below. Change the Project to LOR-80127. 
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 Open the following design file: 
 

…\80127\Design\Survey\RawData\80127_FB001.dgn 
 

 In the Project Explorer dialog, select the Survey tab. By default, the Project Explorer dialog is 
docked on the left side of the screen. If the Project Explorer dialog is not displayed, open Project 
Explorer by selecting File > Project Explorer from the MicroStation pull-down menu. 
 

 Select the Survey group in the Project Explorer dialog. 
 

 Right-click on the Field Books item and select New… to create a new field book. A field book 
named Field Book 1 is created. 
 

 Right-Click on Field Book 1 and choose the Load > File option. 
 

 Change the file filter (located in the lower right of the Select File dialog) to Trimble DC (*.dc) as 
shown on the following page. Load the following data file 
 

…\80127\Design\Survey\rawdata\80127A.dc 

 
 Select Open to initiate processing the selected file. 

 
As the survey data is processed, the mapping is drawn and the terrain model is automatically 
generated. 
 

 After the process is complete, select the Fit View command to view the survey information. 
 
A portion of the survey data is shown on the following page. 
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Take a look at the data. Zoom in and out. Turn on or off levels as desired. Change the 
Annotation Scale to different values, etc… 
 

 
 
 

 After you have finished reviewing the data, select File > Close from the MicroStation pull-down 
menu to close the design file and return to the MicroStation Manager. 
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3 ODOT CADD Standards for Survey 

ODOT Standard Directory Structure 
The ODOT CADD Engineering Standards Manual (ODOTcadd), Section 302 defines the standard project 
directory structure to be used on all ODOT projects. The examples used in this training guide follow the 
standard folder structure. 
 
All new projects are to be created using an ODOT program to create the standard folder structure and a 
MicroStation Project Configuration File (PCF) for the project. ODOT users can access the program can be 
accessed from the Windows Start Menu by selecting All Programs > ODOTcadd > Utilities > 
ODOTcadd_CreateNewProjects.exe. 
 
Users external to ODOT can find the program in the following location: 
 

\ODOTcadd\Standards\ODOT\ProjectTools\ODOTcadd_CreateNewProject.exe 
 
For more information on project creation, see ODOT’s Project Management with the ODOTcadd 
Standards training guide which can be accessed from the Project Explorer dialog by double-clicking on 
the link as shown below. 

 
 

 Using the standard folder structure is not optional! 
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The parent folder for ODOT projects is named using the PID number for the project and may be 
appended with a supplemental description according to the requirements of the ODOT CADD 
Engineering Standards Manual (ODOTcadd), Section 302. 
 
Beneath the PID number folder, the \Design\Survey folder is used to house the field survey information. 
An example project folder with the contents of the Survey folder is shown below. 

 
 

The Aerial folder is used to house aerial mapping for the project. 
 
The Basemaps folder is used to house the survey basemap design 
file (nnnnnn_BE###.dgn) that will be accessed by the designers. 
 
The EngData folder is used to store spreadsheets, Word 
documents, or other surveying and engineering data for the 
project. 
 
The GCS folder is used to store the MicroStation .dty file for 
custom Geographic Coordinate System (GCS) definitions. See 
Chapter 5 for more information. 
 
The RawData folder is used to store datasets for the project as 
well as the survey processing design file (nnnnnn_FB###.dgn). 
 
Additional folders may be added to the Survey folder as needed 
on a project-by-project basis to facilitate specific project needs. 
 
In addition to the Survey folder, survey personnel will use the 
Geopak folder to store the GEOPAK Coordinate Geometry 
database (.gpk file) for the project. 
 

 
The Standards folder is also used by survey personnel to house project specific CADD standards. When a 
new project is initially created using the ODOT program to create the project, the ODOT seed files are 
copied into the \Design\Standards\Seed folder. These seed files will be customized by the surveyor 
when a project specific Geographic Coordinate System (GCS) us used for grid-to-ground translations. See 
Chapter 5 for more information. 
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ODOT Standard Design File Names 
The ODOT CADD Engineering Standards Manual (ODOTcadd). Section 304 File Naming Conventions, 
defines the standard MicroStation design file names to be used on ODOT projects. 
 

 Using the standard design file names is not optional. 
 
Two separate Survey design files are designated: 
 

 The Survey “Field Book” design file is used to process and edit survey information. This file will 
retain all of the survey intelligence and the survey processing “rules”. 
 

 When processing is complete, the survey information is exported to a Basemap design file that 
is used by design personnel. This file contains simple graphics and the terrain model. The survey 
processing “rules” are removed from the file. 
 

Each of these files is described in more detail below. 

Survey Field Book Design Files 

When a new project is created using the ODOTcadd_CreateNewProject.exe program, a survey Field 
Book design file is created in the following folder: 
 

..\Design\Survey\RawData\nnnnnn_FB001.dgn 
 
The file is named using the PID number for the project, appended with “_FB001.dgn”. 
 
This file is generated as part of the project creation process to be used by the surveyor to process the 
survey mapping and terrain model for the project. This file is not intended to be accessed by any other 
personnel. 
 

Survey Basemap Design Files 

After the survey processing and any necessary edits are complete, use the Export DGN Graphics 
command to save the survey information and terrain model(s) a Survey Basemap in the following folder: 
 

..\Design\Survey\Basemaps\nnnnnn_BE001.dgn 
 

The exported DGN file contains only the mapping and the terrain model(s). The Survey “rules”, the 
intelligence that links the survey points and linear elements to the terrain model(s), are removed from 
the exported file. If someone inadvertently moves any of the graphics, the terrain model(s) is not 
affected. 
 
This allows the surveyor to maintain the original field book file with the survey processing rules intact 
and provide a separate design file for use by other personnel on the project. 
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Export DGN Graphics to a Survey Basemap 

To export the survey mapping and terrain model(s) to a separate survey basemap, right-click on a field 
book name and select Export To > DGN Graphics as shown below. 
 

 
 
Enter the name for the new design file and select the Save option as shown below. Be sure to name the 
file according to the ODOT CADD Standards. 

 
Note: The BE file must be updated if changes are made to the survey data. 
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Creating Additional Design Files 

If additional design files are required by the surveyor, ODOT provides a Visual Basic application to assist 
with the creation of MicroStation design files using the ODOT file naming convention. The program can 
be accessed from the MicroStation pull-down menu by selecting ODOT > File Management > New 
Design File. 
 
When the program is initiated, the dialog shown below is opened. 

 
 The program will default to the 2D Seed file for the project. Be sure to change the seed file to 

the 3D seed file for the project when creating additional Survey Field Book design files. 
 

 The Survey Field Book design file is available in the list as shown above. 
 
Note: This program requires that an ODOT Standard directory structure is in place before creating 
design files. Use ODOTcadd_CreateNewProject.exe to create the MicroStation .pcf file and the directory 
structure before using this program. 
 
Additional information about the program can be accessed by selecting the help icon in the upper right 
corner of the dialog. 
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Feature Definitions 
Feature definitions are used to control symbology, annotation, and various other properties that are 
applied to the geometric elements as the survey information is processed. 
 
A feature definition is assigned to each survey point as the data is collected in the field. The ODOT 
Standard field code list is available in Adobe PDF format in the ODOT CADD standards as listed below: 
 

I:\ODOTcadd\Standards\Geopak\Survey\Field_Codes 
 
The feature definitions are used by the software for the following: 
 

 Define what the surveyed information actually represents such as curb, centerline, edge of 
pavement, a mailbox, etc. 

 
 Control symbology in various views, including capability to define differing symbology in plan, 

profile, and 3D spaces 
 

 Define terrain modeling attributes (spot, break line, void, etc.) for each surveyed point or linear 
feature 
 

 Define the display characteristics of terrain models 
 

Point Features 

When survey data is processed, each field shot is stored as a Point Feature in the current Field Book 
within the active model of the active design file. For example, the field code “PP” is used to designate a 
power pole. When the survey data is processed, the power pole code is plotted in MicroStation using an 
ODOT standard cell element as shown below: 

 
Notice that text elements for the point name (SV2230), elevation (978.4720), and field code name (PP) 

are plotted along with the power pole symbol. Each of these text elements are placed on their own level 

and can be toggled on/off as desired. 
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Point Names 

Each survey point in the Field Book must have a unique point name. Point names are assigned in the 
field by the surveyor as the data is collected. There are no specific point name restrictions for the 
OpenRoads Survey product other than ensuring that each point name is unique. 
 
If the survey information will be exported to a GEOPAK Coordinate Geometry database (.gpk file) it is 
important to remember to follow the point naming restrictions inherent to the GPK format. To review, 
the following restrictions apply to GEOPAK COGO point names: 
 

 Point names can be numeric (eight characters max) or alphanumeric (15 characters max) 
 

 Alphanumeric point names must have an alpha prefix followed by a numeric suffix. For example, 
RD22 is acceptable while R2D2 is not. The numeric portion must be greater than zero. 
 

 Special characters, such as % * < etc. are not supported. 
 
Section 306.2 of the ODOT CADD Engineering Standards Manual details standard GEOPAK COGO 
Element names for field collected data. 
 

 Survey shots are to be given the two character prefix “SV” followed by a numeric value. For 
example: SV1000, SV1001, SV1002, etc… 
 

 Monumentation shots can be given the two character prefix “MN” followed by a numeric value. 
 
Care should be taken to avoid the use of duplicate point names when collecting data in the field. The 
OpenRoads Survey product provides options for editing duplicate point names if duplicates are 
encountered during the import process. See Chapter 8 for more information on duplicate point names. 
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Linear Features 

A series of points representing curvilinear features can be connected together as a Linear Feature. 
 
Linking Codes, which are special characters that are entered after feature in the field as the data is 
collected, are used to define the linear features. The following liking codes are configured for ODOT use: 

BL* - Begin Line 
EL* - End Line 
OC* - Point on Curve (begin/end non-tangent curve) 
CL* - Close 
 

 
Important Note! 
This is a change from previous versions of the ODOTcadd Standards. 
 
Previously, the linking code was included after the feature code. In the October 16, 2015 release of 
the ODOTcadd Standards, the default value for the linking code location has been changed to specify 
that the linking code is included after the feature name. This change has been made to facilitate 
drawing the linework on the data collector and in Trimble software. 
 
All field data collected after the October 16, 2016 update shall be collected with the linking code 
listed after the field code. 
 
When processing old datasets with the OpenRoads Survey tools, it is necessary to reconfigure the 
Survey Settings for an individual Field Book design file to specify the location of the linking code 
before the feature code. Instructions on how to make this change are presented later in this chapter. 
 

 
The mapping codes can also be entered as numeric values. The numeric values are defined in the 
ODOTcadd Workspace as shown below: 

1 = BL* 
2 = EL* 
3 = OC* 
4 = CL* 

 
To collect a series of 3 points representing a fence line; each point would be coded as follows in the 
field: 
 

FEN BL* 
FEN 
FEN EL* 

 
If you elect to use the substitution linking codes, the fence line would be coded as follows: 
 

FEN 1 
FEN  
FEN 2 

 



 GEOPAK Survey with OpenRoads Technology 
October 25, 

2016 
 

Chapter 3 – ODOT CADD Standards for Survey Page 37 

 

Linear Features are named according to the feature code name used to collect the shots that define the 
chain. In the above example, a Linear Feature named “FEN” will be created in the field book. If a second 
fence line is collected, the software will increment the name by 1. For example, a second fence line 
would be named “FEN_1”. Subsequent fence lines would be incremented by 1. 
 

Field Attributes 

Many of the ODOT field codes allow for the use of attributes to store additional information with a 
specific survey shot. For example, the feature code “PP”, used to specify a Power Pole, has the following 
attributes: 
 

Material 
Owner 
Pole# 

 
The attributes are plotted in the file similar to the example shown below. 

 
See the ODOT Code list for a summary of feature codes and the associated attributes. 
 

Dual Coded Points 

Combining two unique feature codes and line descriptions within a single point description is supported. 
For example a single field shot could be coded as follows to begin two separate linear features: 
 

EP BL* DR BL* 
 

The above example specifies the beginning of an edge of pavement line (EP BL*) and also the beginning 
of a driveway line (DR BL*). 
 
Since each survey point can only have one field code, two separate points must be stored for dual coded 
survey shots. Point SV2112 is stored at the location of the shot with the field code EP. An additional 
point is stored at the same location with the field code DR. The additional point is named with the same 
point name that was present in the data and appended with “_1”.  In the example above two points will 
be stored in the Field Book named “SV2112” and “SV2112_1”.  This allows the double coded shots to 
represent two features with different feature codes. 
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Seed Files 
A seed file is an empty MicroStation design file that has been configured specifically to meet a particular 
need. When new design files are created, the seed file is copied and renamed to create the new file. 
 
ODOT provides several seed files for use with OpenRoads. When a new project is created using the 
ODOT program, the appropriate seed files are copied into the project’s \Design\Standards\Seed folder.  
 
The ODOT seed files are located in the following folder: 
 

i:\ODOTcadd\Standards\seed\ 
 

 Information on the available seed files is presented in Chapter 5 
 

 3D seed files should always be used for OpenRoads Survey projects. 
 

MicroStation Levels 
ODOT’s CADD Standards include several levels specific to survey information. These levels are grouped 
in the level library using the prefix “SV”. 
 
The levels can be turned on/off using the MicroStation Level Display dialog. The Level Display dialog can 
be opened by selecting Settings > Levels > Display from the MicroStation pull-down menu, or from the 
Level Display icon in the Primary Tools. 
 
The Level Display dialog includes the ability to filter the dialog to only show specific levels. By selecting 
the Survey filter, the dialog will show only the survey levels. 

 
The survey levels include several levels specific to survey data 
that has been mapped using OpenRoads Survey. Each survey 
point displays text on the following levels: 
 

 SV_X_Text_Comment 
 SV_X_Text_Description 
 SV_X_Text_Elevation 
 SV_X_Text_Name 

 
These levels can be toggled on or off as desired using the Level 
Display dialog. 
 
 
 
 
 
 
 

 
 



 GEOPAK Survey with OpenRoads Technology 
October 25, 

2016 
 

Chapter 3 – ODOT CADD Standards for Survey Page 39 

 

For raw datasets, the software also draws Observation Lines and Setup Lines. An example of the 
observation lines is shown below. 

 
 

 Observation Lines are drawn on the level SV_Observation 
 

 Setup Lines are drawn on the level SV_Setup 
 
These lines can be turned on/off using the MicroStation Level Display dialog, or by turning on/off the All 
Setups and All Observations items in the Survey tab of the Project Explorer dialog. 
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Annotation Scale 
MicroStation’s annotation scale is used to control the display of the following items: 

 Text 
 Dimensions 
 Detailing Symbols 
 Cells 
 Custom Line Styles 

 
Cells, text, and custom line styles placed by OpenRoads Survey are drawn according to the current 
MicroStation annotation scale value. 
 
Think of the annotation scale as a multiplier. The original size of the element is multiplied by the current 
annotation scale value to determine the display size of the element. 
 
The cells and custom line styles defined in ODOT’s CADD Standards are defined in one of two ways:  
 

 “Cosmetic” cells and linestyles are used to represent the location of an item, but not the actual 
size of the item. These items are placed in the design file using a scale of 1.0.  The display of 
cosmetic cells and linestyles is scaled automatically by MicroStation using the active Model 
Annotation Scale value. 

o A mailbox is an example of a cosmetic cell that is used to designate the location of the 
item, but not the actual size of the item. 

o A fence line is an example of a cosmetic line style. The location of the “x” on the fence 
line is used as a symbolic representation of the line type and does not represent specific 
post spacing for the fence line. 

o These cells and linestyles will change size when the MicroStation Annotation Scale is 
changed. 

 
 

 “Physical” cells and linestyles are used to represent both the location and the size of an item. 
These items have been drawn at their actual physical dimensions and are placed in the design 
file, by the user, at a scale of 1.0. 

o A pavement marking right-turn arrow is an example of a physical cell which is always 
placed at its actual size. 

o A pavement marking line, such as a lane line, is an example of a physical line style that is 
always placed using the actual dash and gap dimensions of the line. 

o These cells and linestyles will not change size when the MicroStation Annotation Scale is 
changed. 

 
Whether an individual cell or line style can be scaled is defined within the cell and linestyle definition. 
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The display size of cosmetic features can be controlled by the Annotation Scale settings in the Model 
Properties dialog. To access the Model Properties dialog, select File > Models from the MicroStation pull-
down menu. The Models dialog shown below is opened. 

 
Select Edit Model Properties to access the dialog shown below. 

 
 Toggle on the Propagate Annotation Scale option to allow controlling the display size of cells 

and text in the design file by use of the Drawing Scale dialog. 
 

 The Model Properties Line Style Scale option is used to set the display scale for custom line 
styles. Set this value to Annotation Scale for ODOT projects. 

 
Another way to access the Annotation Scale setting is by use of the 
Drawing Scale dialog. The dialog can be accessed by selecting Settings > 
Drawing Scale from the MicroStation pull-down menu. Dock the dialog to 
the top of the window for quick access to the Annotation Scale value. 
 
Changing the Annotation Scale value in the survey basemap file does not 
typically affect the way the file appears to other users who may be referencing the file. 
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ODOT OpenRoads Standards  

Project Explorer > Civil Standards 

The OpenRoads software uses MicroStation DGN Libraries extensively to define various standards used 
by both the Civil and Survey software functions. These DGN libraries are defined by the ODOTcadd 
workspace. 
 
In the ODOT configuration, the file ODOT_SurveyFeatures.dgnlib defines most of the survey standards. 
When a new MicroStation design file is created, these standards are referenced by the configuration 
and can be reviewed from the Civil Standards tab of the Project Explorer dialog. 
 
The Civil Standards tree contains two main branches; one for the active design file, and one for 
Libraries, as shown below. 

 
Within these branches, there are two main 
branches that are used by the Survey 
software: Feature Definitions and Project 
Settings.  
 
When a new file is created, the standards are 
initially listes only in the Libraries branch. 
These are the default standards that are 
defined for ODOT projects. 
 
When survey data is processed, the standards 
are read from the library and are copied to 
the active file. 
 
The default Survey Settings can be modified 
as necessary for a specific survey project. If 
you need to make changes to the default 
values, the default Settings must be copied to 
the active file and modified before processing 
survey data is initiated. 
 

 
To edit the default settings before processing the data, 
right-click on the Survey Settings item in the Libraries 
branch and select Copy as shown at right. 
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The copied settings can be pasted into the active file by 
right-clicking on the Project Settings > Survey item in the 
active file branch, and then selecting Paste as shown at 
right. 
 

 

 

 

When the data is processed, the software will prompt you to 
choose the settings file that you would like to use for 
processing. In order to avoid confusion, it is recommended 
that you change the name of the copied settings to include 
the PID number for the project. An example is shown at 
right. The name can be changed by selecting the Settings 
item, and then selecting it again to edit the name. 
 

 

 

Note: It is only necessary to copy the settings if you wish to make changes to the default values. 
Changes must be made before processing the data. 
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Civil Standards > Feature Definitions 

The Feature Definitions branch of the Civil Standards tab defines the feature library used for mapping 
the survey data and generating the terrain model. When using the ODOTcadd configuration, the 
ODOT_Features_Survey.dgnlib is attached as shown below. 

 
Three types of features can be defined: 
 

 Linear 
 Point 
 Surface 

 
Linear and point features for ODOT use are defined by a linked GEOPAK SMD file, ODOT_SMD.xml. This 
link is established in ODOT_Features_Survey.dgnlib as shown above and contains all the feature 
definitions for the field codes.  The linear and point features defined by ODOT_SMD are merely pointers 
to the .xml file and cannot be edited. 
 
ODOT_Features_Survey.dgnlib also contains the surface feature definitions for existing ground terrain 
models. These features are used for terrain model display and are explained in more detail in Chapter 7. 
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Civil Standards > Project Settings 

The Survey Settings branch defines the default project settings for the Survey software. Once a dataset 
has been processed, these settings are copied to the active design file where then can be edited by the 
user.  
 
To review the default settings, right-click on the Settings item and select Properties to access the 
Element Information dialog shown below. 

 
These settings are set appropriately for ODOT projects; however there are occasions where you may 
wish to change some of the parameters on a per-project basis. 
 
Items that you may occasionally need to edit are documented on the following pages. See the online 
help for information not presented here. 
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General Settings 
A log file of activity can be optionally saved to track changes to the Survey information. In the General 
Settings tab, set the Create Log File option to True as shown below. 

 
The log file is placed in the same folder as the DGN file. 
 
The log file is named with a .log extension using the name of the design file model. 
 
The log file contains the name of the user, the date and time, and a description of the action performed. 
An example of the log file contents is shown below: 
 
ethomas Thursday, December 05, 2013 11:14:08 AM New FieldBook Field Book 1 
ethomas Thursday, December 05, 2013 11:14:16 AM Load Data 
I:\pr\ethomas\OpenRoads\ERI\11311\survey\rawdata\ERI11311-FNL.dc 
ethomas Thursday, December 05, 2013 11:16:35 AM Linear Feature PAINTL1_2 Feature Definition: from: PAINTL1 to: EP 
ethomas Thursday, December 05, 2013 11:17:19 AM Convert to Point List Chain PAINTL1_2 
ethomas Thursday, December 05, 2013 11:17:33 PM Delete Point Feature SV2920 
ethomas Thursday, December 05, 2013 11:18:06 PM Move Point Along Linear Feature Field Book Field Book 1 Linear Feature 
R_34 Point Feature SV1088 

 
 
 
Linking Codes 

 
Note: As previously stated, the Link Code Position parameter has been changed to After Point Feature 
Definition with the October 16, 2015 update to the ODOTcadd Standards. Datasets field collected after 
the October 16, 2015 update should be field collected with the mapping code positioned after the 
feature code name. When processing older datasets containing the linking code before the feature 
name, the survey preferences must be copied into the active file and the value of the Link Code Position 
parameter changed to Before Point Feature Definition before processing the data. 
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Adjustment Defaults 
Various adjustments and blunder detection may be applied to survey raw data. The adjustments and 
adjustment settings apply to the entire field book. 
 
Most of these settings are device-dependent. For example, the Add-on for Distance constant value is 
dependent on the device used to measure distances. 
 
The Adjustment Defaults defined in the ODOTcadd workspace have not been changed from the Bentley 
default values. 

 
 
Terrain Model 

 
The initial settings for terrain models are defined in the ODOTcadd workspace as shown above. These 
values can be changed before processing survey data or after the fact by editing the terrain model 
properties. See Chapter 7 for more information on reviewing and editing terrain models. 
 
Note:  The value of the Create Terrain Model parameter was changed from True to False with the 
October 16, 2015 update to the ODOTcadd Standards. Terrain models are no longer automatically 
created when the survey data is initially processed. 
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MicroStation Design File Settings 
The design file itself also has several settings used by the OpenRoads Survey software. To access these 
settings select Settings > Design File and then click the Civil Formatting item from the list on the left of 
the dialog. 

 
These settings are initially defined in the ODOT Seed files and have been configured appropriately for 

ODOT projects. However, you may wish to change the following settings on a file-by-file basis. 

Coordinate Settings 
 The Format can be set to X,Y, or N,E as desired. 

 
 The Precision setting is used to control the display and precision of coordinates within 

the various civil and survey dialogs. 
 

Station Settings 
Controls the format, delimiter and precision of the station values to be used and displayed in the 
various civil dialogs. In addition, there are two options to control how equations are represented 
within the station values. 

 
 By Name - This is the standard InRoads presentation (A100+00, B105+00, etc.) 

 
 By Index - This is the standard GEOPAK presentation (100+00 R 1, 105+00 R 2, etc.) 
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MicroStation User Preferences 
The MicroStation User Preferences includes several options for the civil products. These parameters are 
accessed by selecting the View Options – Civil item on the Preferences dialog as shown below. These 
options have been configured as necessary in the ODOT workspace. See the Bentley Survey online help 
for more information. 
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Exercise 3 –Linking Codes before the Feature Name 
 
In this exercise we will process an older dataset that contains the linking code before the feature code. 
The data for this example is contained in a Trimble JOB file and must first be converted to an ASCII text 
file in Comma Separated Valued (CSV) format. The Trimble ASCII File Generator is used for the 
conversion. 
 
Before running the ASCII file generator, the following files must be copied from the ODOTcadd 
Standards to the appropriate folder. This task has already been completed on the ODOT computers and 
is detailed here reference. 
 
Copy the following files from ODOTcadd: 
 

Copy the Geoid files from: 
\ODOTcadd\Standards\Trimble\GeoData 
 

To the following location: 
C:\Program Files (x86)\Common Files\Trimble\GeoData 
 

Note: The Geiod Files must also reside on the Data Collector when the data is collected 
 
 
Copy the Style Sheet Files from: 

I:\ODOTcadd\Standards\Trimble\ODOT_SS2 Comma delimited with Attributes.xls 
I:\ODOTcadd\Standards\Trimble\ODOT_SS3 Comma delimited with Attributes.xls 
 

To the following location: 
C:\Trimble Style Sheets\Custom ASCII Files 

 
With these files in place, take the following steps to convert the JOB files to CSV files: 
 

 From the Windows Start Menu, select All Programs > Trimble Office > ASCII File Generator 
 

 
 

 Use the Browse… button to select the Source JobXML or Job File. Select the following file: 
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C:\ODOT_Training\OpenRoadsSurvey\ProjectData\ALL\93756\Design\Survey\RawData\ 
ALL93756TOPO.job 

 
 From the Output format drop down menu, select the ODOT_SS3 Comma delimited with 

Attributes option. 
 

 Select the OK button to initiate the process. 
 

 You are prompted to Include attribute names as shown below, Select the Yes option and 
choose the OK button. 

 
 Next you are prompted to save the CSV file as shown below. Save the file in the RawData folder 

for the project using the same name as the original Job file but with a .csv file extension. 

 
 Finally, you are notified that the file was successfully created. Select OK to complete the 

process. 
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 After converting the first Job file to CSV format, do the same for the second Job file contained in 
the data for this example. Use the ASCII File Generator to convert the following file: 
 
C:\ODOT_Training\OpenRoadsSurvey\ProjectData\ALL\93756\Design\Survey\RawData\ 
ALL93756TOPO2.job 
 

 The CSV file content can be reviewed with an ASCII text editor, or with Microsoft Excel. A 
portion of the first file we converted is shown in Excel below: 

 
 
In the default ODOT configuration, the linking code position is assumed to be after the point name. This 
dataset has the linking codes before the feature name. We must change the setting that defines the 
linking code position before processing the data. Take the following steps to open the MicroStation file 
or the project and modify the default settings: 
  

 Open MicroStation using the shortcut defined for the training class. 
 

 From the MicroStation File Open dialog, select the Project ALL-93756 
 

 Open the following MicroStation design file: 
 

..\Design\Survey\RawData\93756_FB001.dgn 
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 From the Project Explorer dialog, open the Civil Standards tab. 
 
The Libraries > Project Settings item lists the dgn libraries in the ODOT workspace that define 
the default project settings for survey. 
 
The default Survey Settings are defined in 
ODOT_Features_Survey.dgnlib as shown at 
right. 

 
These settings can be copied to the active file 
and then edited before processing the survey 
data. 
 

 Right-click on the Survey Settings item and 
select the Copy option as shown at right. 
 
 
 
 
 
 
 
 
 
 

 
 Paste the settings into the Survey Settings for 

the active file as shown at right. 
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 After copying the settings, the name of the settings can be changed by right-clicking on the 
Settings item and choosing the Rename option. This is optional, but is recommended to 
eliminate any possible confusion of which settings are in use. The name of the settings should 
be changed to include the project’s PID number. 
 

Example: 93756_Settings. 
 

 Right-click on the new copy of the settings and pick the Properties option to edit the settings. 
 

 Change the Link Code Position parameter to Before Point Feature Definition as shown below. 
Close the Element Information dialog after making the change. 

 
Now that the settings have been changed to specify the correct Link Code Position, we are ready to 

process the survey data. 

 Create a new Field Book. You are prompted to choose the survey settings as shown below. 
Choose the 93756_Settings option and then pick the Accept button. 

 
After the Accept button is selected, the Select File dialog is opened as shown below. 
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 Select the file type that you wish to import in the lower right corner of the dialog. For this 
example, choose the ODOT OH83/2011-NF Pt, N, E, Z, Code (*.csv, *.txt) filter. All of the csv or 
txt files contained in the current folder are displayed. 

 
 Import the following file by selecting the file from the list and choosing the Open button. 

 
..\Design\Survey\RawData\ALL93756TOPO.csv 

 
 Import the second data file using the same Field Book. 

 
The data is mapped to the file as shown on the following page. Notice that a terrain model is not 
automatically generated for the data. 
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 Set the design file Drawing Scale to your preferred value to review the data. 
 
This dataset has a few errors that we will fix in a later chapter before creating the terrain model. 
  

 After looking over the data, select File > Save Settings and then File > Save. 
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4 Working with 3D Files 

3D files are normally used for processing Survey data with OpenRoads; however many users have never 
worked in 3D before. This intent of this chapter is to cover some introductory basics of working with 3D 
files and not to provide a comprehensive guide. Further information can be found in the MicroStation 
online help documentation. Additionally, ODOT employees have access to the Bentley Learn server and 
can sign up for online MicroStation 3D training. See your CADD Manager for more information about 
Bentley Learn. 
 

The Design Cube 
3D DGN files consist of a design cube in which you work. The design 
cube represents a 3D DGN file's total volume, in which points are 
defined with x-, y-, and z-values, or coordinates. Points can be 
placed anywhere within the design cube, and are not restricted to a 
single plane as is the case when you work in a 2D DGN file. 
 
Design cube coordinates are expressed in the form (x,y,z). The 

global origin in the 3D seed files provided with MicroStation is 

located at the exact center of the design cube and assigned the 

coordinates (0,0,0). Any point above the global origin has a positive 

z-value and any point below it has a negative z-value. 

 
 
The view volume (sometimes called the display volume) is the volume of the design cube that is 
displayed in a 3D view. In most cases, only a part of the design cube is displayed in a view. 
 

 
 
 “A” denotes the window area (hatched). 
“D” denotes the Display Depth, bounded by the front “F” and back “B” clipping planes. 
The large cube shows the design cube, part of which is displayed in each view. 
 
Any elements or parts of elements, not contained in the view volume are not displayed in the view. 
Unless a clip volume has been applied to a view, the view volume is bounded by the window area, and 
its display depth. 
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Active Depth 
The Active Depth in a view defines the position of a plane, parallel to the screen, on which data points 
are placed. 

 
 
 
The active depth is denoted by “AZ.” 
“x,” “y,” and “z” denote the View axes. 
“F” and “B” denote the front and back clipping planes, respectively. 
 
 
 
 
 

 
You set the active depth graphically with the Set Active Depth view control. 

 
1. Select the Set Active Depth view control. 
2. Select the view in which you want to set the active depth. 
3. Enter a data point at the desired location. 

 
You can also set the active depth for a specific view window using a key-in command. 
 

1. Key in ACTIVE ZDEPTH ABSOLUTE <depth>. 
or Key in AZ= <depth>. 

2. Select the view(s). 
 
You can also query a view window for the current active depth value with the Show Active Depth 
command. 

 
1. Select the Show Active Depth view control. 
2. Select the view. The view's active depth setting is shown in the status bar. 
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Viewing a 3D Model 
A 3D view can display part of the design cube from any point, looking in any direction. 
 

 As in 2D, elements to the left, right, above, or below, can be excluded from a view by zooming in 
or windowing so that the elements are outside the view's area. 

 
 3D views also have depth. You can exclude the display of elements located in front of, or behind, 

a required object by changing the view's display depth, or by applying a clip volume.  See the 
MicroStation online help for information on changing the display depth or applying a clip 
volume. 
 

Note: In the ODOT seed files for OpenRoads, the view attribute for the Clip Volume has been turned off 
for all views. 
 

Display Styles 

The Display Styles dialog is used to select from a list of predefined render overrides that can be assigned 
to a view. 
 
In the view control bar, select the Choose View Display Style icon. A list of available styles is presented 
as well as the option to Open Display Style Dialog. 

 
By default, the display style is set to Wireframe when using the ODOT seed files.  
 
Select the Open Display Style Dialog option to access the Display Styles dialog shown on the following 
page. 
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The predefined list of display styles can be selected and edited using this dialog. When a style is selected 
the preview pane, located at the bottom right of the dialog, shows an example of how the display will 
appear using the selected style. In the example above, the Illustration style is selected. 
 
See the MicroStation online help for more information about editing and defining display seyles. 
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Rotating Views in 3D 

The Rotate View control is used in 3D files to rotate a view to a custom orientation or one of the 
standard views (Top, Front, Right, etc.) as shown below. 

 
When rotating views in 3D, an important point to consider is the axis about which you want the view to 
rotate. By default, the pivot point is the center of the view, at the active depth. If the active depth is far 
behind the elements in the view, then you can quickly rotate the geometry out of sight. You can, 
however, move the pivot point to another location prior to rotating the view as follows:  
 

1. Select the Rotate View view control. 
2. Set Method to Dynamic. A plus sign (+) appears at the center of the view. 
3. Click on the plus sign at the center of the view. 
4. Enter a data point to reposition the pivot point. 

 
 

Clip Volumes 

Clip Volumes can be used to limit the display of the survey data to a specific portion of the model 
without being hindered by elements outside the area of interest. When a clip volume is applied to a 
view, only elements located within the clip volume are displayed, or can be snapped to, in that view. 
Each view may have a different clip volume displayed. 
 
Once a clip volume has been defined, operations such as view rotation, fence processing, and rendering 
honor the clip volumes. Elements that are not displayed within the defined volume are ignored. 
 
The Clip Volume tools can be accessed from the View window as shown on the following page. 
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See the Bentley Online Help for complete documentation of these commands. An example using the 
Apply Clip Volume by Two Points command is documented below. 
 
In the example below, the Apply or Modify Clip Volume command has been selected. The Clip By 2 
Points command is used to define a rectangular region in the top view to be used to define the clip 
volume. 
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Once the rectangular region has been defined, the display of the graphics is clipped as shown below. 

 
 
If desired, the clipped area can be rotated and rendered as shown below. 
 

 
The display of the rectangle representing the clipping limits can be toggled on or off using the Show or 
Hide Active Clip Volume command. 
 
The Clear Active Clip Volume command is used to remove the clipping mask from the selected view. 
 
Clipping elements can be manipulated/modified with the standard MicroStation tools. 
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Drawing in 3D with Civil AccuDraw 
Placing elements in a 2D model is like manual drafting — all elements appear on the same plane, the 
sheet of paper.  
 
In 3D, you place elements in space — horizontally (for example, a floor), vertically (for example, a wall), 
or at any other angle or direction (for example, a sloping roof).  
 
By default, data points in a 3D model are placed at the view's Active Depth. Where you snap a tentative 
point or place a data point in a blank part of a view, it will be located at the active depth. You can, 
however, snap a tentative point to an existing element at any depth in a view. When you accept such 
tentative points, the data point is placed at the level of the snap point. 
 
Civil AccuDraw and its drawing plane let you place elements away from the active depth. Often this 
improves productivity, since you need not constantly change the active depth. 
 
Select Tools > Civil AccuDraw > Activate Toolbar from the MicroStation pull-down menu to open the 
Civil AccuDraw dialog shown below. The first icon is used to turn Civil AccuDraw on or off. 

 
Civil AccuDraw performs many of the same functions as MicroStation AccuDraw but has greatly 
expanded capabilities for the civil designer. 
 

Note: Simultaneous use of Civil AccuDraw and MicroStation AccuDraw will cause errors. Close 

MicroStation AccuDraw when using Civil AccuDraw. 

This guide will cover only a few of functions available when using Civil AccuDraw. For more information, 
see the GEOPAK online help by selecting Applications > GEOPAK > Road > Help. From the Civil Help 
dialog, select Civil Tools > Civil AccuDraw. 
 
The coordinates of the current cursor position are displayed by default in a floating dialog as shown 
below. You can switch between the floating or fixed dialogs using the up and down arrow keys. The 
contents of the dialog will depend upon the current ordinate system selected. 

 
The Tab key is used to move through the key-in 
fields in the dialog. 
 
Values entered in the floating dialog are locked 
when the Enter key is pushed. 
 
To unlock a value, tab to the field and push the End 
key. 
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Shortcuts: Civil Accudraw Settings 
Civil AccuDraw shortcuts and settings are accessed by selecting and holding down the left mouse button 
on the second icon as shown below.  

 
 
These shortcuts are described in the online 
help by selecting Tasks > Civil Tools > 
OpenRoads HElp. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
A single-click on the second icon will open the Civil AccuDraw Settings dialog shown below. 

 
 
These settings are described in the online help by 
selecting Tasks > Civil Tools > OpenRoads Help. 
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Civil AccuDraw Compass 
When the Always Show Compass setting is toggled on, a compass is displayed at AccuDraw’s origin 
point when Civil AccuDraw is active. 

 
 
The compass is always circular and is marked by a number of tics. The default 

is 4 compass points which can be changed in the settings. 

The north arrow on the compass will always point to north as defined in 
Settings > Design File > Angle Readout. 

 
 

If the Civil AccuDraw settings have Context Sensitive turned on (default), then the compass auto-rotates 
in a similar fashion to MicroStation AccuDraw: 

 
Note that rather than direction being shown, the label and value are now an Angle. This is because the 
context is based on the direction of the preceding line segment rather than an absolute direction. 
 
The compass can be rotated with the V, B, T, RQ, RE shortcuts.  
 
V rotates the drawing plane to align with the view axes. 
T rotates the drawing plane to align with the axes in a standard Top view. 
RQ is used to quickly and temporarily rotate the drawing plane. 
RE rotates the drawing plane to match the orientation of a selected element. 
 
Use the T (Top) shortcut or the corresponding drop-down to return to a pure direction. 
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Distance-Direction 
The Distance-Direction ordinate is used to enter points in polar coordinates as shown below. 

 
Angle Syntax 
The input for angle and direction fields follows the MicroStation Settings > Angle Readout settings. 
 
Valid forms for the various settings are as follows: 
 

DD.DDDD, Radians or Grads - Use the customary decimal input. 
 
DD MM SS or DD MM - The following delimiters are supported between degrees, minutes and 
seconds: 
 
Colon - For example DD:MM:SS 
 
^ (caret) to designate degrees, minute (’) and second (”) - For example DD^MM’SS” 

 
The following are not supported in the current version: 
 

A space between degrees, minutes and seconds because space launches the Civil AccuDraw 
popup menu 

 
Use of d, m and s to designate degrees, minutes and seconds. 
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XY 
Rectangular coordinates can be entered by use of the XY ordinate as shown below. 

 
Station-Offset 
The Station-Offset ordinate is used with a reference element to enter information as a station and 
offset relative to a selected element. 

 
The reference element can be a MicroStation element or a Civil Geometry element. If a MicroStation 
element is selected, the beginning of the element is assumed to be station 0+00. If a civil element is 
selected with stationing defined, the station value of the selected element is used. 
 
To select the reference element, with the Station-Offset ordinate active use the O shortcut to select the 
reference element. Once selected, data can be entered using station and offset values relative to the 
reference element as shown in the example above. 
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5 Geographic Coordinate Systems 

MicroStation V8i contains Geo-Coordination features which allow users to specify the position of your 
design contents on the earth´s surface. Once that position is established, the design can be easily 
coordinated with other data for which the geographic location is known. A library of predefined 
Geographic Coordinate Systems, or GCS for short, is available in MicroStation. 
 
NOTE: The intent of the GCS is to define the location of the data for easy integration with other 
georeferenced data. It is not intended to be used to translate the data from grid to ground, or vice 
versa, on the fly. Once defined, the survey data should be left in the defined coordinate system. 
 

Selecting a GCS 
The GCS can be selected by choosing Tools > Geographic > Select Geographic Coordinate System from 
the MicroStation pull-down menu. The Geographic Coordinate System dialog shown below is opened. 

 
To choose a GCS from the library, select the second icon, From Library. The Select Geographic 
Coordinate System dialog shown below is opened. 

 
The ODOT workspace defines the State Plane coordinate systems typically used on ODOT projects in the 
ODOT folder as shown above. Choose the appropriate GCS from the list. A different GCS can be selected 
by browsing the Library folder. The available GCS definitions in the delivered library for Ohio are shown 
on the following page. 



October 25, 
2016 

GEOPAK Survey with OpenRoads Technology  

 

Page 70 Chapter 5 – Geographic Coordinate Systems 

 

 
The GCS definitions for Ohio shown above are available by selecting Library > Projected (northing, 
easting) > North America > United States of America > Ohio. 
 
When a GCS is initially selected, you are simply telling MicroStation where the data resides. It is 
important to note that choosing a GCS when one has not been previously defined does not re-project 
existing data in the design file to the selected GCS. The data is only re-projected when changing from 
one GCS to another. 
 
Once a GCS is defined, MicroStation understands the geographic location of your design and provides 
additional capabilities such as:  
 

 Referencing other geo-located designs and raster data. 
 Displaying geographic latitude and longitude. 
 Entering latitude and longitude data. 
 Interfacing with a Global Positioning System device to correlate your physical position with the 

design on a mobile computer. 
 
 
 
 
 



 GEOPAK Survey with OpenRoads Technology 
October 25, 

2016 
 

Chapter 5 – Geographic Coordinate Systems Page 71 

 

ODOT Seed Files 
When a new project is created using the ODOTcadd_CreateNewProject.exe program, the Geographic 
Coordinate System for the project can be selected. The program then copies the ODOT seed file for the 
selected coordinate system to the \Design\Standards\seed folder for the project. Coordinate with the 
person who initially creates the project to ensure that the correct GCS is selected for the project. 
 
The following seed files are available in the ODOTcadd Standards: 
 

North Zone 
Seed Files 

 i:\ODOTcadd\Standards\Seed\ODOTSeed2d_OH83-NF.dgn 
 i:\ODOTcadd\Standards\Seed\ODOTSeed3d_OH83-NF.dgn 

GCS used: 
 OH83-NF – NAD83 Ohio State Planes, North Zone, US Foot 

 
Seed Files 

 i:\ODOTcadd\Standards\Seed\ODOTSeed2d_OH83-2011-NF.dgn 
 i:\ODOTcadd\Standards\Seed\ODOTSeed3d_OH83-2011-NF.dgn 

GCS used: 
 OH83/2011-NF – NAD83 Ohio State Planes, North Zone, US Foot 

 
 

South Zone 
Seed Files 

 i:\ODOTcadd\Standards\Seed\ODOTSeed2d_OH83-SF.dgn 
 i:\ODOTcadd\Standards\Seed\ODOTSeed3d_OH83-SF.dgn 

GCS used: 
 OH83-SF – NAD83 Ohio State Planes, South Zone, US Foot 

 
Seed Files 

 i:\ODOTcadd\Standards\Seed\ODOTSeed2d_OH83-2011-SF.dgn 
 i:\ODOTcadd\Standards\Seed\ODOTSeed3d_OH83-2011-SF.dgn 

GCS used: 
 OH83/2011-SF – NAD83 Ohio State Planes, South Zone, US Foot 

 
 

No GCS Defined 
Seed Files: 

 i:\ODOTcadd\Standards\Seed\ODOTSeed2d.dgn 
 i:\ODOTcadd\Standards\Seed\ODOTSeed3d.dgn 

GCS Used: 
 None 

 
The 3D Seed files should always be used for OpenRoads Survey projects. 
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Custom Geographic Coordinate Systems for Grid to Ground Conversions 
Depending on the project, it may be necessary to convert the data from a State Plane coordinate system 
to ground coordinates for use by the designer, or use with other information that has already been 
converted to ground coordinates. This can be facilitated by using Bentley Map software by creating a 
custom MicroStation GCS. Once defined, the custom GCS can be shared with all users working on the 
project. 
 
The steps to create a custom GCS are summarized below: 
 

1. Compute the combined scale factor for the project. 
 

2. Copy the MicroStation seed.dty file to the \Design\Survey\GCS folder for your project. This file 
will be used to define the custom GCS. 
 

3. Define the MicroStation configuration variable MS_GEOCOORDINATE_USERLIBRARIES to specify 
the custom .dty file that contains the custom GCS definition. Note: This is done for you if the 
project was created using the ODOTcadd_CreateNewProject.exe tool. 
 

4. Enable Bentley Map to edit the custom GCS definition to enter the combined scale factor. 
 

5. Make the GCS available to other users of the project data by creating seed files for the project. 
 

Note: If the project folder structure and PCF file were created using the 
ODOTcadd_CreateNewProject.exe tool, steps 2 and 3 are completed for you. 

 

Defining the GCS when using ODOTcadd_CreateNewProjects 

If you used the ODOTcadd_CreateNewProjects.exe application to create the project, the steps to define 
the GCS have been simplified as much as possible. Take the following steps to define the GCS for the 
project. Note that this process should be done before the designers start work on the project. 
 

1. Establish the Combined Scale Factor for the project 
To convert from grid coordinates to ground coordinates for a limited areal extent, a mean 
elevation factor and a mean scale factor for a region are multiplied to create a combined scale 
factor that is used for the custom GCS definition. The combined scale factor must be known 
before proceeding. 
 
The process to establish the combined scale factor for the project is outside the scope of this 
document. If the combined scale factor is unknown, contact the District Survey Operations 
manager. 
 

2. Copy the Seed Files to the project folders. This task is completed for you when the project is 
created using the ODOTcadd_CreateNewProjects.exe application. 
 

3.  Define the MS_GEOCOORDINATE_USERLIBRARIES variable. This step is completed for you 
when a MicroStation PCF file is created using the ODOTcadd_CreateNewProjects.exe 
application. 
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4. Edit the custom GCS to include the combined Scale Factor. 
Open the survey Field Book design file for the project. Bentley Map is used to define the custom 
GCS and must be activated in order to edit the custom GCS definition. 

 
 Activate Bentley Map by selecting GEOPAK > Map > Activate Map from the MicroStation 

pull-down menu. 
Take the following steps to define the parameters for the custom GCS definition: 
 

 Select Tools > Geographic > Select Geographic Coordinate Systems to open the Geographic 
Coordinate Systems dialog. 

 
 Select the From Library icon to access the Select Geographic Coordinate System dialog. 

Right-click on the custom GCS name and choose Edit Coordinate System Parameters as 
shown below. 

 
The Edit Geographic Coordinate System dialog shown on the following page is opened. 
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Take the following steps in order to define the custom GCS for the project: 
 
 Change the Name using the three-character County abbreviation and PID number for the 

project. Note that the name must start with alphabetic characters. 
 

Example: JAC-98167 
 
 Edit the Description field to prepend it with the words “Ground Coordinates”. 
 
 The Projection parameter should already be set to Lambert Conformal Conic with Affine 

Processor.  
 

Map transformations will now initiate two processes: the map projection transformation 
followed by an affine transformation.  Six additional parameters for an affine transformation 
are added to the Edit Geographic Coordinate System dialog as shown below. 
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 Insert the combined scale factor value for the affine parameters A1 and B2 which are set to 

a value of 1 as shown above. 
 
Note: Compute the inverse if you are given the combined ground to grid factor 

 
To help distinguish ground coordinates from grid coordinates, large values can be inserted 
into A0 for X and B0 for Y. This step is not normally done for ODOT projects. 
 
The A2 and B1 parameters should be 0. 
 

 Select OK on the Edit Geographic Coordinates dialog to accept the changes. 
 

 Select OK on the Select Geographic Coordinate System dialog to change to the ground 
coordinate system that you have just defined. 

 
Note that this only defines the coordinate system for the active model in the active design 
file. The coordinate system must also be defined in any other models contained in the active 
file as well as the seed files for the project. 
 
If you are changing the GCS definition to a new coordinate system, you ae prompted as 
shown on the following page. 
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If the survey data is mapped using ground coordinates, and you are assigning a ground 
coordinate system, choose the Correct the Geographic Coordinate System – do not reprojec t 
the data option. 
 
If the data was mapped in grid coordinates, and you wish to transform the data, choose the 
Reproject the data to the new Geographic Coordinate System option. 
 
If the data was mapped on a grid coordinate system, and you wish to leave it on the grid, then 
do not choose the new ground coordinate system in the Select Geographic Coordinate System 
dialog. The designers can still use the new GCS definition to create design files in ground 
coordinates while referencing a survey basemap that is defined in grid coordinate values. The 
assigned GCS in the designer’s file will align the two different coordinate systems as necessary. 

 
 

5. Assign the custom GCS to the seed files for the project. 
After the parameters for the custom GCS have been defined in the active Model in the Field 
Book survey design file, the GCS must also be assigned to the sheet model in the field book file 
as well as all models of the project specific seed files. An ODOT MicroStation Visual Basic 
application is provided for this task. 
 
From the MicroStation pull-down menu, select ODOT > Survey > AssignGCS to Seed Files. The 
dialog shown below is opened. 
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The Project Folder value defaults to the current project folder as defined by the variable 
_USTN_PROJECTDATA which is defined in the PCF file for the project. 
 
The GCS Name defaults to the currently assigned GCS in the active model. If no GCS is assigned, 
the application terminates. 
 
Select Assign GCS to Seed Files to initiate the process. The program will search for dgn files in 
the following location, starting from the directory specified by the Project Folder definition: 

 
\Design\Standards\Seed 

 
In addition to processing the seed files, the program will process all of the models in the active 
design file. 
 
When complete, the program will issue a message detaining the seed files that were processed. 
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Data Processing Scenarios 
For ODOT projects processed using OpenRoads Survey the recommended procedure is to provide the 
surveyed information using State Plane coordinates with a custom GCS defined that can be used to 
reposition the data in ground coordinates if necessary. This provides a consistent product for ODOT’s 
design staff, is consistent with the way Aerial mapping is delivered, and will reduce confusion over 
exactly what is being provided. 
 
There are several processing scenarios to consider in order to provide the surveyed information in State 
Plane coordinates. Some common scenarios are presented below. 
 
Raw observation data: 
 

 Scenario 1: Control points on the State Plane, observations measured on the ground 
 
When processing raw data and the control points are in State Plane, set the GCS to the 
appropriate State Plane Zone before processing. 
 

 If you would like to have the software compute the combined scale factor, set the Civil 
Standards > Survey Settings Combination Scale Factor Option value to Compute From 
Control Points when processing raw data. The combined scale factor is reported in the 
Adjustment report (right-click on the Adjustment option in the Project Explorer dialog’s 
Survey tree to show reports) 

 

 If the scale factor is known, select the Use Manual Combined Factor option to enter the 
value in the Combined Scale Factor Value field. 

 
Entering the scale factor, or having the software compute the scale factor, will ensure that the 
ground distances are scaled to the state plane grid, thus resulting in all your computed survey 
points being in state plane grid too. After that you can translate the data to ground by selecting 
a custom GCS for the project. 
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 Scenario 2: Control points on the ground, observations measured on the ground 
 

If your control points are ground coordinates, then set your survey settings Combined Scale 
Factor Option value to Do Not Use to process the raw data. The data will remain in ground 
coordinates. 
 
To translate the ground coordinates to the grid, it will be necessary to make a custom GCS for 
the ground coordinates using a combined scale factor. The custom GCS can be defined before or 
after processing as long as you have not previously selected a GCS. Once a custom GCS has been 
assigned, you can then choose the appropriate State Plane Zone to translate the data to the 
grid, if desired. 
 
Reduced Coordinates ASCII files: 

 
 Scenario 3: Coordinates from RTK in State Plane 

 
When importing ASCII coordinates using an OpenRoads Survey TIW (Text Import Wizard), the 
coordinate system of the ASCII file can be defined as part of the wizard. 

 

 If the ASCII coordinates are in a State Plan Zone, the coordinate zone for the ASCII file 
has been defined in the TIW, and the MicroStation file is set to ground coordinates using 
a custom GCS, the survey software knows to do a transformation on the fly when 
bringing in the coordinates. 

 

 If the ASCII file is in State Plane coordinates, set the GCS to the appropriate State Plane 
zone and bring in the coordinates. The data can then be converted to ground using a 
custom GCS. 

 
 Scenario 4: Ground coordinates 

 
The custom GCS can be defined in the Survey TIW (Text Import Wizard). If a State Plane GCS has 
been defined in the active file, the survey software will do the translation on the fly when 
bringing in the coordinates. 
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CGS Frequently Asked Questions: 
 

 Do I have to define a GCS? 
 

The GCS is used to coordinate information defined in one coordinate system with information 
defined in another coordinate system. If you are not working with data that is defined using 
multiple coordinate systems or you do not need to do any grid-to-ground conversions with the 
data, then a GCS does not need to be selected. However, defining the GCS for the data may 
provide advantages for other users of the data. 

 
 Does choosing a GCS automatically reposition data already drawn in the design file? 

 
The initial selection of a GCS does not reposition data that is already drawn in the design file; 
you are simply telling MicroStation where the data resides. 

 
If a GCS has been previously defined, choosing a different GCS will transform the data to the 
newly select GCS. 

 
 What happens if I choose the wrong GCS and need to change it later? 

 
If a GCS has been previously defined, when a new GCS is selected you are prompted whether to 
reposition the data as shown below. To correct the GCS, choose the option Correct the 
Geographic Coordinate System – do not reposition the data as shown below. 

 
 What if I have defined a custom GCS for ground coordinates in the Survey design file but the 

designers are using design files with no zone defined? 
 

As long as the designers are tying into/referencing the survey data to lay out their design, this 
really does not matter. If you have created and activated a custom GCS for grid to ground 
transformation, the designers are working in ground coordinates whether they know it or not. 
The custom GCS definition can be applied to the designer’s files at any time, if needed. 
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 What do I do if I am adding new survey data that is in grid coordinates to an existing design file 
in ground coordinates, and the existing design file does not have a custom GCS defined? 

 
The best way to handle this is to create a custom GCS for the grid to ground conversion before 
importing the new data. After applying the custom GCS to the existing design file, the existing 
data can be repositioned on the grid by selecting the appropriate State Plane GCS before 
importing the new survey data. 
 
Remember, the initial selection of the GCS does not reposition existing data in the design file, it 
just tells MicroStation where the data resides. 

 
 What do I do if I am adding new survey data that is in grid coordinates to an existing design file 

that has a custom GCS defined? 
 
When survey data is imported, the TIW (Text Import Wizard) can be configured to specify the 
coordinate system for the data. If the coordinate system is defined in the TIW, the survey 
software will transform the data on the fly as it is imported. 
 

 What happens if the design file I am in has a GCS defined but I reference a file/model that does 
not have a GCS defined? 
 
The reference attachment will be displayed at the coordinates specified in the referenced model 
as they relate to the selected GCS in the active file. For example, a telephone pole drawn at 
coordinates (1000, 1000) in the referenced model will display at coordinates (1000, 1000) in the 
active file. 
 

 What happens if the design file I am in does not have a GCS defined but I attach a reference to a 
file that does have a GCS defined? 
 
The reference attachment will be displayed at the coordinates specified in the referenced model 
as they relate to the coordinates in the active file. For example, a telephone pole drawn at 
coordinates (1000, 1000) in the referenced model will display at coordinates (1000, 1000) in the 
active file. 
 

 What happens to reference file attachments if I change the GCS in the active file? 
 

Reference file attachments are not repositioned when changing the GCS in the active file. If the 
data needs to be displayed on a different GCS, each file/model must be edited individually to 
change the GCS. 
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 What happens if I reference a model from a design file that has a different GCS defined? 

 
When a reference is attached, an Orientation option is available to reposition the data using the 
master GCS as shown below. 

 
 How are OSIP imagery and Mr. Sid files impacted by the GCS? 

 
MicroStation design file preferences have settings for georeferences as shown below. In general, 
you should not have any problems referencing imagery when a GCS is defined. 
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Longitude and Latitude Coordinates 
When a geographic coordinate system is assigned to a model, it appears in the Auxiliary Coordinates 
dialog (Tools > Coordinate Systems > ACS > Auxiliary Coordinates). When it is made the active auxiliary 
coordinate system, data can be entered in longitude, latitude format, and coordinate readout can be set 
to show longitude and latitude. 
 

 Select Tools > Coordinate Systems > ACS > Auxiliary Coordinates to open the Auxiliary 
Coordinates dialog shown below. 
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 Right-click on the coordinate system in the list and choose either the Set Active View or Set all 
Views option. 

 
 To get a longitude, latitude coordinate readout, turn on Running Coordinates by right-clicking 

the status bar (located to the lower left of the MicroStation window as shown below). 

 
 

 Next, click on the coordinates (located at the bottom of the MicroStation window, towards the 
right side) and select ACS Position. 

 
As the cursor is moved in the MicroStation window, the running coordinates will display in longitude and 
latitude format as shown in the example below: 

 
The mode, precision, and format of the longitude and latitude values are controlled in the Design File 
Setting dialog under Angle Readout and Working Units. 
 
Click on the coordinates display and select Position to change the readout back to X, Y, Z coordinates. 
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Exercise 4 – Defining a Custom GCS for Grid to Ground Conversions 
In this exercise we will create a custom Geographic Coordinate System for the JAC-98167 dataset. The 
survey data for this example is contained in two .dc files; one for the topography, and one for the bridge 
deck. The data files are in ground coordinates. 
 

 When the project was created using ODOTcadd_CreateNewProject.exe, the DTY file for the 
OH83/2011 South coordinate system was copied into the project folder: 

 
C:\ODOT_Training\OpenRoadsSurvey\ProjectData\JAC\98167\Design\survey\GCS\98167_custom.dty 

 
Verify that the file exists in the folder listed above. 

 
 The MicroStation Project Configuration File (PCF) file for the project contains the configuration 

variable definition to assign the custom DTY file. Open the following PCF file to verify that the 
variable definition exists: 
 

C:\ODOT_Training\OpenRoadsSurvey\ProjectPCF\JAC-98167.pcf 
 
The variable is defined as follows: 
 

MS_GEOCOORDINATE_USERLIBRARIES = 
$(_USTN_PROJECTDATA)survey/GCS/98167_Custom.dty 

 
 Open MicroStation using the shortcut for the training class. 

 
 From the MicroStation File Open dialog, select the Project configuration file JAC-98167 

 
 Open the following design file. The Survey Data has already been processed for the project. 

 
\Survey\RawData\98167_FB001.dgn 

 
 From the Survey group in the Project Explorer dialog, create a new field book for the first .dc file 

by right-clicking on the Field Books item and choosing the New... option. Right-click on the new 
field book and choose the Properties option to rename the field book to “Topo”. 
 

 Load the first data file by right-clicking on the new field book and choosing the Load File option. 
Load the following data file: 
 

\Survey\RawData\JAC-98167-TOPO.dc 
 

 We will process the bridge deck information in a separate field book. Create a new field book 
and rename it “Bridge Deck”. Load the following data file into the bridge deck field book. 
 

\Survey\RawData\JAC-98167-BD.dc 
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 Activate Bentley Map by selecting Applications > Map > Activate Map from the MicroStation 
pull-down menu. 

 
 Select Tools > Geographic > Select Geographic Coordinate System to access the Geographic 

Coordinate System dialog. 
 

 From the Geographic Coordinate System dialog, select the From Library icon to access the Select 
Geographic Coordinate System dialog. 
 

 A folder containing the GCS definition is available in the library. Right-click on the custom GCS 
and choose the Edit Coordinate System Properties option. Make the following changes: 

 
Name:  JAC-98167 
Description: Ground Coordinates NAD83 Ohio State Planes, North Zone, US Foot 
A1 Parameter: 1.000079806 
B2 Parameter: 1.000079806 

 
 Apply the changes to save the new GCS definition. When the Geographic Coordinate System 

Changed dialog opens, select the option: Correcting the Geographic Coordinate System – do 
not reproject the data. 

 
Next we will update the seed files for the project to use the GCS definition. 
 

 When the project was created, the following seed files were copied into the \standards\seed 
folder for the project: 
 

\98167\Design\standards\seed\98167_Seed2d.dgn 
\98167\Design\standards\seed\98167_Seed3d.dgn 

 
The seed files can be updated to use the custom GCS definition by use of an ODOT MicroStation 
Visual Basic application. From the MicroStation pull-down menu, select ODOT > Survey > Assign 
GCS to Seed Files, as shown below. 
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The dialog below is opened.  

 
The Project Folder defaults to the value defined for the project in the MicroStation PCF file. 
 
The GCS Name defaults to the currently assigned GCS in the active MicroStation model. 
 
Select the Assign GCS to Seed Files button to initiate the process. The defined GCS is assigned to 
the seed files for the project. 
When the process is complete, a report is displayed to the user documenting the files that were 
processed similar to the example below. 

 
 After the process is complete, open the seed files to verify that the GCS was assigned properly 

 
 When complete, exit MicroStation. 
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6 Processing Reduced Coordinates 

Reduced Coordinates CSV File Format 
CSV files containing reduced coordinates are normally created from a Trimble JOB file using the Trimble 
ASCII File Generator as detailed in Chapter 3 of this training guide. When the ASCII File Generator is used 
to create the CSV file, the format of the CSV file is fixed and can be imported using one of the predefined 
import formats. 
 
Occasionally it may be necessary to import a CSV file that has the columns arranged in a different order. 
When you import reduced coordinate files in CSV (Comma Separated Value) format, a TIW (Text Import 
Wizard) file is used to specify the format of the .csv file. Let’s take a look at the procedure to define your 
own TIW files. 
 
The TIW file is simply an ASCII file that defines the fields contained in the .csv file to be imported. An 
example of a TIW file with a defined GCS is shown below: 
 

Data Type                        = Delimited 
Start Row                        = 1 
Record Format               = Simple 
Comma                            = Yes 
Column Format              = Point Name 
Column Format              = Northing 
Column Format              = Easting 
Column Format              = Elevation 
Column Format              = Code 
Projection Input             = OH83-SF 
Projection Output 

 
The Text Import Wizard is invoked when importing data into a Field Book by selecting Load > File Using 
Text Import Wizard… as shown below. 

 
The Select File dialog is opened to select the .csv file to import. 
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After the file is selected, the Text Import Wizard dialog is opened as shown below. 

 
The contents of the selected CSV file are displayed in the dialog. 
 
Use the Back and Next buttons to step through the options to configure the TIW file. When the Next 
button is selected, the option to define the delimiter is available as shown below. For CSV files, check on 
the Comma option as shown below. 

 
Select Next to move to define the contents of each column in the CSV file as shown on the following 
page. 
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Each column in the CSV file has a header that is used to define the contents of the column. Each column 
will default to Skip as shown above. Clicking on the column heading will reveal a list of options that can 
be used to define the column content as shown above. 
 
After defining each column, select Finish to complete the TIW configuration. The TIW file can be saved 
and reused should you need to reimport the data, or copied to another project for reuse without the 
need to step through the TIW configuration process. You are prompted to save the TIW and to choose a 
name/location to save the file. Saving the TIW file is optional. 
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Exercise 5 – Configuring TIW Settings 
In this exercise we’ll import a comma separated ASCII file containing reduced coordinates for a project 
using the Text Import Wizard. 
 

 Open MicroStation using the shortcut for the training class. 
 

 From the MicroStation File Open dialog, select the Project configuration file MUS-92256 and 
open the following design file: 
 

\Survey\RawData\92256_FB001.dgn 
 

 Create a new Field Book. 
 

 Edit the field book properties to name the field book M92256A2 
 

 Right-click on the new field book and choose the Load > File Using Text Import Wizard… option. 
The Select File dialog is opened. Open the following file: 
 

\survey\rawdata\M92256A2.csv 
 
The Text Import Wizard dialog is opened. 

 
The content of the selected CSV file is displayed in the dialog as shown above. 
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 Geographic Coordinate Systems can be defined as part of the TIW import process. From the Text 
Import Wizard dialog, select the Projections button to access the Projections dialog shown 
below. 

 
Use the Select button to choose the GCS for the data. 
 
The Target is ignored by the software. The active GCS in MicroStation is used as the target. If the 
active GCS is different than the source GCS, the survey software will adjust the data on the fly. 

 
 Select the Next button on the Text Import Wizard dialog to move to the next step of the wizard. 

 
Define the Delimiter by checking on the Comma option. The data is separated into columns as 
shown below. 

 
Select the Next button to go to the next step of the wizard. 



October 25, 
2016 

GEOPAK Survey with OpenRoads Technology  

 

Page 94 Chapter 6 – Processing Reduced Coordinates 

 

 The next step of the wizard will allow you to define the contents of each column. Each column 
has a drop down menu of options to identify the content of the columns. By default, each 
column is set with a value of Skip. 

 
 Define each column appropriately before selecting the Finish button. For this dataset, the 

columns should be defined as listed below. Note that there are five attributes in this dataset. 
 

Point Name 
Northing 
Easting 
Elevation 
Code 
Attribute Name 
Attribute Value 
Attribute Name 
Attribute Value 
Attribute Name 
Attribute Value 
Attribute Name 
Attribute Value 
Attribute Name 
Attribute Value 

 
 Select the Finish button to initiate processing the data. 
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 You are prompted to create a new tiw file. Select Yes to save the tiw file in the \survey\rawdata 
folder for this project. Name the file using the five digit PID number for the project: 92256.tiw 

 
 You are next prompted to save the tiw file format in the import settings. Select Yes to save 

these settings for this project. 
 
The data is mapped to the file and the terrain model is created. 
 

 Set the design file Drawing Scale to your preferred value to review the data. 
 

 After looking over the data, select File > Save Settings and then File > Save. 
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7 Reviewing and Editing Survey Data 

Reviewing and Editing Points 
To review a single survey point, simply float the cursor over the point. A pop-up menu with information 
about the point will appear similar to the example below. 

 
The MicroStation Element Selection command can be used to review or edit various properties of a 
selected point. When a point is selected, a menu of commands will appear onscreen as shown below. 

 
The following commands are available: 

 Properties 
 New Point Feature 
 Turn on/off Name 
 Turn on/off Feature 
 Turn on/off Description 
 Turn on/off Elevation 
 Turn on/off Custom Operations 
 Turn on/off All annotations 
 Report 
 Create Control Point 
 Edit Observations 
 Delete 
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Select the Properties item from the pop-up menu to access the dialog shown below. 

 
This is the easiest way to edit the attributes of a point. Nearly every field in the dialog is editable. 
 
Note: The Scale fields represent the current MicroStation Annotation Scale setting and should not be 
edited. 
 
In addition to the pop-up menu options, two editable fields are displayed below the selected point. 
 
Terrain Model Attribute 
To edit the Terrain Model Attribute, select the point and then select the first field as shown below. 

 
To change the value, use the up and down arrow keys on the keyboard. 
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Link Code 
To edit the Link Code, select the point and then select the second field as shown below. 

 
To change the value, use the up and down arrow keys on the keyboard. 
 
 

Moving Points 

Occasionally it may be necessary to graphically move a point to a new location. When a survey point is 
selected using the MicroStation element selection tool, the origin of the point is highlighted with a circle 
as shown in the example below. 
 

 
Using the Element Selection tool, the circle can be selected to move the point, however, when a point is 
moved by selecting the circle it will not only be moved to the X,Y position you choose but also to the 
current MicroStation Active Elevation. 
 
To move a point and preserve the elevation value, use the Element Selection tool to select the survey 
point at any location other than the circle at the point origin. Drag the point to the new location. The Z 
value will be preserved when moving a point in this manner. 

 
To move a point to known coordinates, edit the coordinate values in the Point Properties dialog shown 
on the previous page. 
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Editing Points with the Survey Details Dialog 

The Survey Details dialog is accessed by selecting the Show Details icon from the Tasks dialog as shown 
below.  

 
The content of the Survey Details dialog is determined by the selected item in the Survey tab of the 
Project Explorer.  In the example on the following page, the DAR-185 field book is selected. Information 
about the field book is displayed in the Survey Details dialog. 
 

 
 
Selecting the Point Features item under a dataset will display all the points for the dataset in the Survey 
Details dialog. The Point Features item can be expanded to reveal the point features that are included in 
the dataset. Selecting one of the Point Features will display only the points that use the selected feature 
as shown in the example below. 
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Some of the fields in the Survey Details dialog can be edited by selecting the field, and then by clicking 
in the selected field. An example editing the Name field is shown below. 
 

 
 
Individual points or a group of selected points can be edited in the Survey Details dialog by right-clicking 
on the area to the left of the selected point(s). The editing options shown on the following page are 
available. 
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Changes made to the data are dynamic and are applied instantly. For example, if a point is deleted the 
graphics are removed from the file, the terrain model is updated (if applicable) and any Linear Features 
that contain the point are updated. 
 
If you make an edit that you did not intend to make, simply select the MicroStation Undo command. The 
last action is reverted. 
 
 

Reviewing and Editing Linear Features 
There are three types of linear feature definitions in OpenRoads Survey: 
 
Dynamic Linear Features 

 Dynamic linear features are composed of points of the same feature 
 The chains are generated dynamically using the feature name and the linking codes 
 These chains will dynamically update on the fly if changes are made to the linking codes or to 

the feature associated with a point(s) in the field book 
 The order of the point list cannot be changed; points are connected in the order that they were 

numbered in the field 
 
Point List Linear Features 

 Point list linear features are comprised of a list of survey points 
 The order of the points is used to determine the linear feature geometry 
 Linking codes are also used to define the shape of the linear feature 
 Points can be included in the chain list in any order 
 The points that make up a point list linear feature can have different feature codes 
 These linear features are just like survey chains in GEOPAK Survey 

 
Graphic Linear Features 

 Graphic linear features are drawn one at a time as a MicroStation graphic, ether by converting a 
point list linear feature to a graphic linear feature or by importing a 3D MicroStation graphic line 

 If you convert a point list linear feature to a graphic linear feature any subsequent edits to the 
points that originally defined the chain will not update the graphic linear feature. This allows 
users to make edits to the graphic chain using MicroStation commands. 

 Graphic linear features can be include in the terrain model 
 
These linear feature types are hierarchical. A Dynamic Linear Feature can be converted to a Point List. A 
Point List type can be converted to a Graphic type. 
 
The ODOTcadd Survey Settings have been configured to generate Point List Linear Features as the 
default. 
 

Note: This setting was changed with the October 16, 2015 release of the ODOTcadd Standards. 
Previous versions of the ODOTcadd settings were configured to use the Dynamic Linear Feature 
as the default. 
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To review a single linear feature, simply float the cursor over the element to reveal a pop-up menu 
similar to the example below. 

 
The MicroStation Element Selection command can be used to review or edit various properties of a 
selected linear feature. 
 
When a Dynamic Linear Feature is selected, a menu of commands as shown below will appear 
onscreen. 

 
The following commands are available if the selected linear feature is a Dynamic Linear Feature: 

 Properties 
 Append Point in Linear Feature 
 Move Point Along Linear Feature 
 Insert Point in Linear Feature 
 Close Linear Feature 
 Break Linear Feature 
 Transpose Linear Feature 
 Move Linear Feature 
 Report 
 Convert to Point List Linear Feature 
 Manage Point List 
 Edit Point Features 
 Delete 

 
 
 
 



October 25, 
2016 

GEOPAK Survey with OpenRoads Technology  

 

Page 104 Chapter 7 – Reviewing and Editing Survey Data 

 

When a Point List Linear Feature is selected, a menu of commands as shown below will appear 
onscreen. 

 
The following commands are available if the selected linear feature is a Point List Linear Feature: 

 Properties 
 Append Point in Linear Feature 
 Remove Point from Linear Feature 
 Join Linear Features 
 Move Point Along Linear Feature 
 Insert Point in Linear Feature 
 Close Linear Feature 
 Break Linear Feature 
 Transpose Linear Feature 
 Move Linear Feature 
 Report 
 Convert to Graphic Linear Feature 
 Manage Point List 
 Edit Point Features 
 Delete 

 
 
When a Graphic Linear Feature is selected, a menu of commands as shown below will appear onscreen. 

 
The following commands are available if the selected linear feature is a Graphic Linear Feature: 

 Properties 
 Delete 
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Select the Properties item to access the dialog show below. The properties of a dynamic linear feature 
are shown below. 

 
Many of the fields in the Linear Features Properties dialog can be edited directly in this dialog. 
 
Linear features can also be edited using the Survey Details dialog. An example is shown below. 
 

 
 
In the example above, the feature CP was selected from the Linear Features list in the Project Explorer 
dialog. All of the CP linear features for the data file are displayed in the Survey Details dialog. A right-
click in the selection margin to the left of the Name field will reveal the editing options shown above. 
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Reviewing and Editing Terrain Models 
Terrain models are manually generated after the survey data is processed by right-clicking on a Field 
Book name and choosing the Create Terrain Model… option as shown below, 

 
Note: Multiple datasets contained in one field book are combined to make one terrain model. 
 
When using the ODOTcadd workspace, the triangles and the external boundary of the terrain model is 
visualized as shown below.  
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Use the MicroStation Element Selection tool to select a terrain model in the design file to reveal the pop-
up menu shown below. 

 
The following commands are available: 
 

 Properties 
 Set As Active Terrain Model 
 Export Terrain Model 
 Update From Source 
 Delete 

 
The Properties options are shown below. 

 
Edge Method 
In the ODOTcadd workspace, the default Edge Method has been set to Max Triangle Length with a 
Length value of 100. The following Edge Method options are available: 
 

 None 
 Slivers 
 Max Triangle Length 

 
The option to key in a Length value is only available when the Edge Method is set to Max Triangle 
Length. 
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Contours, Triangles, Triangle Vertices, Flow Arrows, Low Points, High Points 
This display of each of these items can be toggled on or off using these options. Note that these options 
do not turn on/off the MicroStation level display for these items. 
 
Breakline, Boundary, Void, Spot 
This display of each of these items can be toggled on or off using these options. 
 
Feature Name 
The Feature Name is the file name that will be used when the terrain model is exported to GEOPAK 
format. 
 
Feature Definition 
The Feature Definition item is used to select the surface feature that will be used to control the terrain 
model display. Surface feature definitions are defined in ODOT_Features_Design.dgnlib. When using 
the ODOTcadd workspace, the surface feature X_Triangles is the default. This feature has been 
configured to diplay the terrain model triangles and boundary. Various surface features are available in 
the ODOTcadd workspace with triangles and contours toggled on. 
 
Edits made to the points and linear features that comprise the terrain model are immediately and 
dynamically reflected in the terrain model. 
 
For example, deleting a point as shown below… 

 
…is immediately and dynamically reflected in the terrain model as shown below. 
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The Task Navigation dialog’s Survey group contains a host of commands in the Terrain Model group for 
editing and analysis as shown below. 

 
For a complete list of these commands, see the OpenRoads online help. 
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Disable Survey Processing Rules 

The terrain model is dynamically updated as changes are made to the survey data. If you wish to use one 
of the Terrain Model tools to edit the terrain model (for example, to remove some unnecessary edge 
triangles), it is necessary to first disable the survey processing rules for the design model. Once disabled, 
the terrain model can be freely edited independent of the survey data. The survey processing rules can 
be disabled by right-clicking on the model name in the Survey tab of Project Explorer and selecting 
Deactivate Survey Processing Rules as shown below. 

 
Also note that once deactivated, changes to the Survey data will no longer update the terrain model. 
 
Once deactivated, a lock icon will be displayed next the model name in the Survey tab of Project 
Explorer as shown below. 

 
The survey processing rules can be enabled by selecting Activate Survey Processing Rules as shown 
below, however, reactivating the rules means that the terrain model will be updated to reflect the 
survey data and any edits that you may have made using the Terrain Model tools will be disregarded. 
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Report Crossing Features 

Report Crossing Features is available from the Terrain Model task menu as shown below. Note that the 
terrain model processing rules do not need to be deactivated in order to use this command. 

 
When selected, the command will prompt you to select the terrain model and whether to apply an 
elevation tolerance to the results, as shown below. The elevation tolerance can be used to filter out 
crossings that have an elevation difference smaller than the value specified. This is useful to filter out 
crossings at points that are dual coded to define two separate feature lines such as a point that defined 
the edge of pavement and the start of a driveway. 

 
After stepping through these two prompts, the Terrain Crossing Features Report shown on the 
following page is opened. 

 
The following commands are available at the top of the dialog: 
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Feature Types 
This drop-down menu provides a list of terrain model features types that will be considered for inclusion 
when crossing features are detected. Each feature type can be toggled on/off as desired. 
 
Zoom To 
This command is used to zoom to the selected crossing. 
 
In View 
Selecting the In View option filters the list of crossings to only display those that are contained within 
the current view extents. 
 
Export 
This command is used to generate a Terrain Crossing Features Report. 
 
When the Zoom To command is selected, the current crossing is displayed in the MicroStation view 
window with a yellow warning icon at the crossing location. 

 
The crossing lines are highlighted in red and blue corresponding to the red and blue text shown for 
Feature Type 1 and Feature Type 2 in the Terrain Crossing Features Report dialog. The crossings are 
rectified using point and linear feature editing commands as there are no commands in the Terrain 
Crossings Feature Report dialog to edit the crossings. 
A variety of methods can be used to resolve the crossing features. Right-click on a crossing in the Terrain 
Crossing Features Report dialog to reveal the menu shown below. 
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As each crossing is resolved it is removed from the dialog list. 
 
In some cases, it may be desirable to use the MicroStation Move Element command to slightly move 
one of the points; however care must be taken when moving points to ensure that the original elevation 
of the point is retained. When moving elements in 3D files, the default MicroStation behavior is to move 
the element to the Active Depth. 
 
To move a point and preserve the elevation value, use the Element Selection tool to select the survey 
point at any location other than the circle at the point origin. Drag the point to the new location. The Z 
value will be preserved when moving a point in this manner. 

 
 
. 
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Removing Edge Triangles 

After survey processing and editing is complete, it may be necessary to delete some of the terrain model 
edge triangles that are formed in areas along the boundary of the terrain. 
 
The example below shows several triangles that are formed across an area where no survey data was 
collected. 

 
Setting the terrain model’s Edge Method to Max Triangle Length with a shorter value can eliminate 
some of these triangles, however it may still be desirable to manually remove some of these triangles. 
 
Terrain models are “ruled” by the survey points and chains. Changes made to the survey points and 
chains are dynamically reflected in the terrain model. Before editing triangles, it is necessary to turn of 
the survey processing rules so that the terrain model is disconnected from the survey elements. To do 
so, right-click in the name of the active Model in the Project Explorer’s Survey group and select 
Deactivate Survey Processing Rules as shown below. 

 
When the rules are deactivated, a lock icon will display next to the model name. 
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OpenRoads provides a variety of terrain model creation and editing commands in the Civil Tools > 
Terrain Model group of the Tasks menu group as shown below. 

 
These tools are documented in the OpenRoads 
help. 
 
The Edit Terrain Model tool can be used to remove 
the edge triangles from a terrain model. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
This command will allow you to remove edge triangles one at a time. Each triangles is highlighted as 
shown below. Issue a Data Point to remove the highlighted triangle. As each triangles is removed, the 
next triangle is highlighted. 
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Alternately, the Delete Triangle by Line command can be used to drag a line through several triangles to 
be deleted as shown below. 

 
After editing the terrain model to remove any unnecessary edge triangles, the Create Terrain Model 
Boundary tool is used to assign a boundary to the terrain that will be maintained when the Survey 
Processing Rules are turned on. This tool is located in the Terrain Model group of the Tasks menu as 
shown below. 

 
The tool has three options: 
 

 Extract Graphic - extracts the current boundary for the triangulation to an editable 3D linestring. 

 Add Boundary - extracts the current boundary for the triangulation as an explicit boundary in 
the terrain element - ie locked boundary. 

 Add Ruled Boundary - extracts the current boundary for the current triangulation to an editable 
ruled draped boundary element. Deleting this element will remove the boundary from the 
terrain. 
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Use the Add Boundary method to add a fixed boundary to the selected terrain model. Don not assign a 
Feature Definition or a Name for the boundary. 

 
After the boundary is added to the terrain model and the Survey Processing Rules are turned back on, 
edits to the survey information will still be applied to the terrain model, however, the Max Side Length 
and Slivers methods for setting the terrain boundary are no longer available. Reviewing the properties 
of the terrain model shows that the Edge Method is set to By Boundary as shown below. 

 
If additional survey information is added outside of the terrain model boundary, this information will not 
be added to the terrain model unless the boundary is deleted. The terrain model boundary can be 
removed using the Remove Terrain Model Boundary tool in the Terrain Model task group. Removing 
the boundary and enabling the Survey Processing Rules will automatically add the new survey data to 
the terrain model, however previous edits to the edge of the terrain will be lost. 
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Exercise 6 – Correcting the ALL-93756 Dataset 
 
In this exercise we’ll fix a few problems with the ALL-93756 dataset. 
 

 Open MicroStation using the shortcut for the Survey Training class. 
 

 From the MicroStation File Open dialog, select the ALL-93756 Project. 
 

 Open the Field Book design file for the project. 
 

 Zoom in on the building in the South-Western quadrant of the project. The fourth corner of the 
building was miscoded as BLC as shown below. 

 
 Edit the properties of the point to change the Feature Definition to the correct field code of 

“BLD” (select the point and choose the Properties item from the pop-up menu). 
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 After changing the feature definition for the point, we can add the point to the linear feature for 
the building. Select the building line and choose the Append Point in Linear Feature option as 
shown below. 

 
 Choose the point that you wish to append to the linear feature. Accept the solution. When 

complete, the linear feature for the building should appear as shown below. 
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Next we’ll fix a second building in the south-eastern quadrant of the project. Unlike the previous 
example this one does not have a surveyed point at the back corner of the building. We’ll use the Close 
Linear Feature command to assume a point to close the building. 
 

 Select the building in the south-eastern quadrant of the project and choose the Close Linear 
Feature command as shown below. 

 
 The software has two options for closing the figure. 

 
Choose True to construct perpendicular lines as shown below to close the figure. Choose False 
to close the figure by constructing a straight line from the first and last points. For this example, 
choose True. 
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Next we’ll fix a Top of Bank feature that was accidentally miscoded and crosses over the survey data as 
shown below. 

 
Points 2312 and 2313 should have been included in the linear feature named TB1. First we’ll remove 
these two points from the TB_4 linear feature. 
 

 Select the TB_4 linear feature and choose the Remove Point From Linear Feature option. 

 
 Remove both points from the linear feature. 
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 Next we will insert both points into the linear feature TB1_5. Select the linear feature TB_5 and 
choose the Insert Point In Linear Feature option 

 
 Inset points 2313 and 2313 into the linear feature. 

 
The last error we will fix is a crossing break line in the north-eastern quadrant of the project. 
 

 Select the linear feature named “B” and choose the Move Point Along Linear Feature option as 
shown below. We’ll use this command to slide point 2121 along the linear feature to move it so 
it does not overlay the other break line. 

 
 Select point 2121. As the cursor is moved, the elevation for the point is determined by either 

holding the current elevation or allowing the software to compute the elevation value by sliding 
the point along the slope of the line. Set the Point Feature Hold Elevation value to True to 
retain the original elevation value. 
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 Issue a data point at the position that you wish to move the point to. When complete, the lines 

no longer overlap. 
 
After making these edits, we will create a terrain model for the project. 
 

 In the Project Explorer dialog’s Survey group, right-click on the field book name to choose the 
Create Terrain Model option. A terrain model for the project is created from all of the datasets 
contained in the field book. 

 
The terrain model should be reviewed for crossing break lines and also for areas where the triangles 
may extend across areas where no data was collected.  
 

 Use the Report Crossing Features command discussed earlier in this chapter to review and edit 
crossing features. 

 
After reviewing and correcting crossings, the next editing operation is to remove any edge triangles that 
may extend across areas where no survey data was collected. 
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The Edge Method for terrain model creation defaults to Max Triangle Length with a value of 100. Before 
removing any extraneous edge triangles, try changing the Length parameter to a shorter value. 
 

 Select the terrain model and choose the Properties option to access the dialog shown below. 
Try changing the Length parameter to 50 or 75 and review the results. If the Length is set too 
short there may be areas where triangles that you wish to maintain are removed. 

 
After adjusting the triangle Length parameter, the next step is to edit the terrain model to remove any 
unnecessary edge triangles. 
 

 In order to edit the terrain model, we need to first deactivate the Survey Processing Rules as 
shown previously in this chapter. Once the rules are deactivated, we can make edits to the 
terrain model. 
 

 Choose the Edit Terrain Model command from the Tasks menu as shown below. 

 
 
 
 
 
 
 
 



 GEOPAK Survey with OpenRoads Technology 
October 25, 

2016 
 

Chapter 7 – Reviewing and Editing Survey Data Page 125 

 

 From the Edit Terrain Model tool settings, choose the Delete Triangle By Line command to 
remove any unwanted edge triangles by dragging a line through the triangles as shown in the 
example below. 

 
 After removing any unwanted edge triangles, the next step is to create a fixed boundary for the 

terrain model. Choose the Create Terrain Model Boundary command as shown below. 

 
 Select the terrain model and use the Add Boundary option to add the boundary to the terrain 

model. 
 

 After adding the fixed boundary to the 
terrain model, we can now reactivate the 
Survey Processing Rules. In the Project 
Explorer dialog, select the Model name and 
choose the Activate Survey Processing 
Rules option. 
 
 
Changes to survey data within the interior of the terrain  model will now update the terrain, 
however the boundary will remain fixed unless the boundary is removed from the terrain model 
by choosing the Remove Terrain Model Boundary command in the Tasks menu. 
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The data is now ready to be exported to a survey basemap for use by the designers on the project. Take 
the following steps to export the file to a survey basemap design file, removing the survey “rules”. 
 

 From the MicroStation menu, select File > Save Settings. 
 

 From the Survey group in the Project Explorer dialog, right-click on the field book and choose 
Export To > DGN Graphics… as shown below. 

 
 Save the new file to the \Design\Survey\Basemaps folder as shown below. Name the file using 

the PID number for the project followed by “_BE001.dgn”. 

 
 After the export is complete, the software will open the newly created file. The survey mapping 

and the terrain model are contained in the new file; however, the survey processing rules are 
removed. 
 

 You may wish to lock the data to prevent accidental edits. To do so, use the MicroStation 
Element Selection tool to select all the elements in the file. Choose Edit > Lock to lock all the 
selected elements. After completing this task, choose File > Save Settings and then exit 
MicroStation. 
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8 Processing Multiple Data Sets 

Handling Duplicate Point Names 
When processing multiple datasets for the same field book it is not unusual to encounter duplicate point 
names. There are two cases where this typically occurs: 
 

1. The same control points are contained in multiple datasets. 
 

2. The field crew accidentally collected new data using the same point names as a previous 
dataset. 

 
In either case, the duplicates can be handled upon import. When each dataset is imported the software 
will notify the user of any duplicates as shown below. 

 
The Prefix and Suffix fields can be used to append the point names with a user defined prefix or a suffix.   
 

 When assigning prefixes or suffixes, care must be taken to ensure that the resulting point names 
will be compatible with GEOPAK COGO naming conventions if the survey points will be exported 
to a GEOPAK GPK file. 

 
 See Chapter 3 for information on COGO survey point names 

 
 See Chapter 14 for information on exporting data to GEOPAK formats. 

 
The Counter field is used to add a value to the point names. The accompanying key-in field is used to 
specify an increment factor. 
 
The Differences tab, shown on the following page, will allow you to compare the values for each point 
before deciding which action to take on the Option tab. 
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Exercise 7 – Processing Multiple Trimble .dc Files 
In this exercise, we’ll import two datasets in a raw data format and perform a few edits to correct 
various errors. 
 

 Open MicroStation using the shortcut for the training class 
 

 From the MicroStation File Open dialog, select the Project configuration file LOR-12121 and 
then open the following MicroStation design file 

 
\Survey\RawData\12121_FB001.dgn 

 
 Create a new Field Book named LOR-511 

 
 Load the following data files: 

 
\Survey\RawData \lor511a.dc 
\Survey\RawData \lor511b.dc 

 
 Four duplicated point names will be encountered. Choose the appropriate action (Overwrite, 

Skip, Rename, Next Name). 
 

 After importing both datasets, change the MicroStation Annotation Scale to your preferred 
value. 
 
Note: You may want to turn off the level for the Setup Lines and the Observation Lines before 
reviewing and editing the data. 

 
 From the MicroStation pull-down menu, select File > Save Settings.  
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9 Correcting Errors 

Exercise 8 – Correcting Errors 
Occasionally a survey point or linear feature will be miscoded in the field.  These coding errors are easy 
to correct in OpenRoads Survey. In this exercise, we’ll correct a few code errors using the design file 
from a previous exercise. 
 

 Open MicroStation using the shortcut for the training class 
 

 From the MicroStation File Open dialog, select the Project configuration file LOR-12121 and 
then open the following MicroStation design file: 

 
\Survey\RawData \12121_FB001.dgn 

 
 Notice that there are two yellow warning icons displayed in the dataset as shown below. 

 
Open the Survey Details dialog to review the warning messages as shown below. 
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 Right-click on the warning message in the Survey Details dialog and select the Zoom To option to 

find which warning icon in the design file corresponds to the selected message. Note, that this 
option is really a window center operation and not a true zoom.  Use the MicroStation view 
controls to zoom in the desired amount before selecting the Zoom To option. 

 
Point SV1676 has been miscoded in the field. Edit the point to change the Feature Definition to 
PAD (select the point and choose the Properties option to edit the Feature Definition). The 
point will dynamically be included in the linear feature named PAD as shown below. 

 
This particular linear feature represents a headwall, not a concrete pad, so we’ll need to make 
additional edits to the data to correct the feature code for all the points in the linear feature and 
also to close the linear feature. 

 
 To edit the Feature Definition for all of the points in the linear feature, use the MicroStation 

Element Selection tool to select the linear element. From the pop-up menu, select Edit Point 
Features as shown below. 
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The Survey Details dialog displays the points that make up the linear feature. Select all the 
points and right-click in the selection margin at the left of the Name column to access the menu 
shown below. Change the Feature Definition to WALLH for the selected points as shown below. 

 

 
 

 To close the linear feature, Use the MicroStation Element Selection tool to select the linear 
feature. Choose the Manage Point List option from the pop-up menu. The Linear Feature dialog 
shown below is opened. 
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Change the LinkCode option for point SV1676 to Close. Select the Accept button. The linear 
feature is closed and dynamically updated. 

 
 Open the Survey Details dialog and use the Zoom To command to move to the next warning 

message. Point SV1778 should be coded as WALLA. 
 

After changing the feature code to WALLA, the point is dynamically included in a linear feature.  
 
Use the Edit Point Features… command to change the LinkCode for point SV1778 to Close. 
 
A visually inspect of the data will reveal a few minor problems. Make the following edits: 

 
 There is a problem with the edge of pavement lines crossing on the west side of the project. 

Point SV1214 has a feature definition of EP1. This point should have been coded as EP. Use the 
point Properties dialog to change the feature definition for point SV1214 to EP. Since the linear 
features are defined as dynamic link features, the point is automatically included in the linear 
feature EP and is removed from the linear feature EP1. 
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 The ODOT tree and shrub line feature definitions are defined uniquely for cases where the 
woods are to the surveyors left or right depending on the direction of survey. To use these 
codes correctly, if the woods or the shrub line are on the surveyors left the WOODSL or SHRUBL 
codes should be used. Conversely, if the woods or the shrub line are on the surveyors right, the 
WOODSR or SHRUBR codes should be used. 
 
There are three tree lines in the survey data. Each of them displays the arcs representing the 
tree line in the wrong direction. There are two ways to correct this problem: 
 

o Select the linear feature and choose the Transpose Feature command.  
o Change the feature definition for the points that make up the linear feature to use 

either the WOODSL or WOODSR feature definition as necessary. 
 

Try correcting the problem using each method described above. 
 

 A driveway at the west side of the project has been accidentally coded as a drainage ditch. 
Locate the driveway shown below and edit the point list to change the feature definition from D 
to DR for each side of the driveway. 

 
 

 From the MicroStation pull-down menu, select File > Save Settings. 
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10 Graphic Linear Features 

When collecting survey data in the field, it is not always easy to predict how the survey data will be 
triangulated. Occasionally, it may be necessary to append the field data by drawing some 3D graphic 
break lines to insert into the surface in order to provide a better triangulated model. This can be 
accomplished by inserting a Graphic Linear Feature into the surface. 
 
A graphic linear feature can be any MicroStation graphical element. Editing consists of using 
MicroStation tools to draw or modify the element. The symbolization of these linear features can be 
controlled by the assigned feature, but assigning a specific feature is an option – not a requirement. 
 

Exercise 9 – Graphic Linear Features 
In this exercise, we will place two graphics elements in a 3D file, representing the base of a headwall, 
and then import these elements into the survey data as a break line. 
 

 Open MicroStation using the shortcut for the training class 
 

 From the MicroStation File Open dialog, select the Project configuration file LOR-12121 and 
then open the following MicroStation design file: 

 
\Survey\RawData \12121_FB001.dgn 

 
 Optional: 

o Change the Annotation Scale to 1:5 
o Turn off the following levels: 

 SV_Observation 
 SV_X_Text_Comment 
 SV_X_Text_Description 
 SV_X_Text_Elevation 

 
This will reduce the overlapping text and make it easier to read the point names when zoomed 
in on each point. 

 
 Zoom in on the linear feature named WALLA as shown on the following page. This feature 

represents the top of the headwall. 
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Let’s take a look at how the triangles were formed for this dataset. 
 

 Select the terrain model and choose the Properties command from the pop-up menu. 
 Change the Feature Definition to X_Triangles 
 Change the view Display Style to Illustration > Default as shown below. 
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Now let’s rotate the view to get a better look at how the triangles are formed around the 
headwall on the south side of the road. Use the Rotate View command to orient the view similar 
to the example below. 

 
Notice that some of the triangles are formed such that they extend from the top of the headwall 
out into the ditch. The bottom of the headwall was not coded as a break line by the field crew. 
Rather than send the crew back out to pick up additional points, we’ll draw a 3D MicroStation 
SmartLine that can be inserted into the terrain model as a graphic linear feature. 
 
There are some surveyed points in the dataset that we can draw a 3D SmartLine through in 
order to better define the bottom of the headwall. 

 
 Set the active MicroStation level to DT_X_Break_Line 

 
 Change the MicroStation Display Style back to Wireframe 

 
 Draw a MicroStation SmartLine element through the following points: 

 
SV1621, SV1781, SV1782, SV1844, SV1845, SV1619 

 
 To include the 3D SmartLine in the terrain model, use the MicroStation Select Element tool to 

select the element, and then choose the Add To Terrain Model icon as shown on the following 
page. 
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 Set the Feature Type as Break Line as shown below. 

 

 
 

 Follow the prompts to accept the Terrain Model and the Feature Type. The 3D Smartline is 
added to the terrain model which is dynamically updated as shown below. 
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The headwall on the other side of the road has a similar problem. Take the following steps to better 
define the bottom of the headwall: 
 

 Choose the MicroStation level DT_X_Break_Line 
 

 Draw a SmartLine through points SV1769, SV1772, SV1786, SV1795, SV1780, SV1779, SV1777. 
 

 Add the line as a new graphic linear feature. 
 

 Set the MicroStation display mode to Illustration and rotate the view to admire your handiwork. 
A rotated view showing the terrain model from the south east using the Feature Definition of 
Existing Ground 5’ Contours is shown below. 

 

 
 
 

Caution! 
Be careful when adding graphic break lines that you do not create an overhang situation where 
the graphic break line goes underneath the top of the headwall. 
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11 Bridge Surveys 

Field Codes 
The ODOT Feature Code list includes the field codes listed below for bridges. The information in this 
section is provided in order to better define the codes and their intended use. 
 

Field Code Description Terrain Model Attribute 

BD Bridge deck Do Not Include 

BOB Bottom of the beams Do Not Include 

BRFLOOR Bottom of the bridge deck Do Not Include 

BRRAIL Top of the bridge railing or parapet Do Not Include 

BRSEAT Beam seat elevation shots Do Not Include 

PIER Perimeter of the pier Do Not Include 

PIERCB The bottom of the pier cap Do Not Include 

PIERT The outline of the pier cap Do Not Include 

WALLA The outline of the abutment wingwall or the face of the 
abutment breastwall. Shoot the bottom of the wall as a break 
line. 

Break 

 
BD: Bridge Deck is used to determine toe to toe of parapet and perimeter of the bridge deck. 
 
BOB: Bottom of beam is used to determine vertical clearance and location of the beams. Use judgment 
to determine the points of critical vertical clearance. The minimum shots for BOB are one at each 
bearing. If the beams might be reused, shoot the web for one exterior beam. Also shoot any changes in 
the bottom of the beam due to cover plates. Shoot a point on each side of the change in section.  
Measure the center to center spacing of the beams. This will be used to determine the location of the 
beams. 
 
BRFLOOR:  Bridge Floor is used to determine out to out of bridge deck and bottom of bridge deck. This is 
especially important for slab bridges and stage construction. If stage construction is considered, a shot 
should be taken where the deck will be cut for stage construction. Discuss with the project manager if 
this shot is necessary and exactly where the shot should be taken. 
 
BRRAIL: Bridge Rail is used to locate the barrier. This information may be needed if the parapet is to be 
reused. Discuss with the project manager where the shots on the railing should be taken. 
 
BRSEAT:  will be used for the elevation of the beam seat. Take shots as close to the centerline of each 
beam as possible. Record where the point was taken in relation to the beam. These shots will used in 
conjunction with the BOB to determine the height of the bearing device. 
 
PIER:  used to determine location, and size of pier columns. 
 
PIERCB:  used to determine location, skew, and size of pier cap. 
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PIERT:  Pier Top is used to determine location, skew, and size of pier cap. These shots are used to 
determine the skew of the pier cap.  Take a shot at the top and bottom of each step in the pier cap.  
Also, take a shot on the opposite side of the pier cap. These shots will be used to determine the width of 
the pier cap. 
 
WALLA:  The purpose of these points is to determine the location and skew of the abutment. From 
these shots we would also like to be able to get the outline of the wall. For the wing walls, at a minimum 
get a point at all four corners and another shot along each face of the wing wall. Shoot the bottom of 
the wall or where the ground meets the wall as a break line. If you are collecting the bridge information 
as a separate job on the data collector, the WALLA feature code should be included with in the 
topographic data, not in the bridge data. 
 

Terrain Model Requirements 
For projects containing one or more bridges, the existing ground terrain models should not include any 
of the bridge information. A separate terrain model is required for the surface of each bridge. 
 
Note that the bridge codes in the ODOT Field Code list are all configured with the terrain model 
attribute set to Do Not Include with the exception of the WALLA code. This will ensure that the ground 
terrain model for the project contains the existing ground information under the bridge and does not 
include the bridge itself. 
 

Data Collection Procedures 
The recommended practice for bridge surveys is to collect all of the bridge information as a separate job 
in the data collector. This ensures that all the necessary data for the bridge is isolated from the ground 
terrain survey and can be used to easily generate a terrain model for the bridge deck information. Note 
that the WALLA feature should be collected with the topographic information, not as part of the bridge 
job ib the data collector. 
 
If the bridge information has been collected in the same job on the data collector as the topographic 
survey, the easiest way to generate the surface of the bridge is to use the Bentley Civil Terrain Modeling 
tools to create the bridge deck surface from 3D graphics rather than the OpenRoads Survey tools. 
 
An example of each approach is provided in the following two exercises. 
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Exercise 10 – Creating a Bridge Terrain Model Using Separate Data Files 
 
In this exercise we’ll process survey data in which the bridge information was collected as a separate job 
on the data collector. Each portion of the data will be processed into separate field books. 
 

 Open MicroStation using the shortcut for the training class 
 

 From the MicroStation File Open dialog, select the Project configuration file MAD-16653 and 
then open the following design file: 
 

\Survey\RawData\16653_FB001.dgn 
 

 Create a new field book and name it MAD 665-397 Topo. Load the following data file: 
 

\Survey\RawData\MAD-665-397.sdr 
 
This data file contains the topographic survey for the project. The data is imported as shown 
below. Notice that a terrain model was not automatically generated for the data. 

 
 

 Create a second field book for the bridge information. Rename the new field book to: MAD-665-
397 Bridge 

 
 Load the following data file: 

 
\Survey\RawData\MAD-665-397BRID.sdr 

 
The data is imported as shown on the following page. A terrain model is not generated for this 
field book either. 
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Note: In the Project Explorer dialog, you can turn on/off the display of the data for each field 
book using the check boxes next to the field book name as shown below. 

 
 To create a terrain model for the topo data, right-click on the field book name and choose the 

Create Terrain Model… option as shown below. 

 

A terrain model is created using the name of the field book. 
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The field book containing the bridge deck information will be used to create a second terrain model for 

the bridge deck. This data file includes some features that are will be included in a terrain model (X) as 

well as the bridge deck feature (BD) that is not included in the terrain model.  

 To include the bridge deck in the terrain model, select the bridge deck element and choose the 
Properties option from the pop-up menu. Change the Terrain Model Attribute item to Break 
Line as shown below. 

 

Note: Any other features, such as the LINE2D feature code, that are not normally included in the 

terrain model can be added to the bridge deck terrain model by changing the Terrain Model 

Attribute to the appropriate value. 

 Create the terrain model for the bridge deck by right-clicking on the field book name and 
choosing the Create Terrain Model… option. A second terrain model is created for the project as 
shown in the Project Explorer dialog’s Civil Model tab below. 
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Take the following steps to display the terrain models: 
 

 Change the Feature Definition for the Topo terrain model to Existing Ground Triangles 
 

 Change the Feature Definition for the Bridge terrain model to Existing Bridge Deck 
 

 Set the Edge Method for the bridge deck terrain model to Maximum Triangle Length with a 
value of 1 foot. 

 
 Change the View Display Style to Illustration 

 
An example of the completed terrain models for the project is shown in a rotated view below. 
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Exercise 11 – Creating a Bridge Deck Terrain Model from 3D Graphics 
In this exercise we’ll import multiple datasets to define the existing ground terrain as well as generate a 
separate terrain model for a bridge deck. 
 
The survey data for this project includes both ground terrain information as well as the bridge deck 
information in the same survey dataset. The bridge was not collected as a separate job on the data 
collector. 
 

 Open MicroStation using the shortcut for the training class 
 

 From the MicroStation File Open dialog, select the Project configuration file DAR-11222 and 
then open the following design file: 

 
\Survey\RawData\11222_FB001.dgn 

 
 Create a new Field Book and import the following datasets: 

 
\ Survey\RawData \DAR118CHANX.sdr 
\ Survey\RawData \DAR1180849.sdr 
\ Survey\RawData \DAR1180849B.sdr 
\ Survey\RawData \DAR118WL.sdr 
\ Survey\RawData \DAR118VRS.sdr 

 
 After the datasets have been imported a new terrain model is automatically created. Edit the 

terrain model properties to set the Display Feature to X_Contours 05’ Major. Notice that the 
edge of pavement and the center of pavement lines stop short of the bridge deck. This causes 
the contour lines to drop off before the terrain surface reaches the bridge deck. 

 
 Turn off the levels DT_X_Contour_Major  DT_X_Contour_Minor, and any other unnecessary 

levels to clean up the screen display before moving to the next step. 
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The Create From Elements tool, located in the Task Navigation dialog’s Terrain Model group, is 
used to create a new terrain model from selected 3D MicroStation graphics. 

 
Depending on how the survey data was collected, creating a terrain model for the bridge deck 
can be as simple as selecting the bridge deck element(s) or can involve edge of pavement and a 
centerline lines that were collected across the surface of the bridge deck using the LINE2D 
feature code. 
 
In this dataset, the perimeter of the bridge deck was collected as one closed element and the 
edge of pavement and center of pavement lines were stopped short of the bridge as shown 
below. 
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 It may be desirable to connect the edge and center of pavement lines by drawing 3D lines across 
the bridge in order to generate a crowned surface for the bridge deck. Before we generate the 
terrain model, draw lines across the bridge as shown below. Use the level DT_X_Break_Line for 
these graphics. 

 
The next step is to trim the lines so that they meet the bridge deck limits. We’ll also draw two 
lines along the edges of the bridge deck as shown on the following page. 
 
Note: This method assumes that the profile of the bridge deck surface is on a continuous slope 
and is not in a vertical curve. 
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 Use the MicroStation Trim To Element tool to trim the lines to intersect the bridge deck as 
shown below.  

 

 
We will use these 5 lines to generate the bride deck terrain model. 
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 Select the Create From Elements tool from the Terrain Model group in the Task Navigator. 

 
 Set the Feature Type to Break Line 

 Set the Edge Method to None 

 Set the Feature Definition to X_Bridge Deck 

 Name the terrain model using the PID number for the project as follows: 
11222_BridgeDeck 

 
Select each of the lines when prompted to Locate Element to Add as shown below. Each line 
will be included as a Break Line in this terrain model and is hilighted as you select the elements.  

 
Reset when you have finished selecting the lines. 
 
You are now prompted to accept the settings. Issuse a data point to accept the Feature Type 
and Edge Option paramaters. Upon completion, the terrain model is created. 
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 Now it’s time to examine your handiwork. Take the following steps to view the terrain models. 
 

o Select the AllFieldBooks terrain model and change the Feature Definition to X_Triangles 
o Turn on the level DT_X_Triangles if it is not on 
o Turn off the level BR_X_SV_Deck_Top 
o Change the MicroStation Display Style to Illustration 
o Rotate the view to review the terrain model triangulation 

 
With this dataset there is a drop-off between the pavement and the bridge deck surface at each 
end of the bridge. Additional editing to the existing ground terrain model is necessary to 
eliminate the drop off. This can be facilitated by drawing a 3D line string at each end of the 
bridge deck to be inserted into the existing ground terrain model. 
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 Use the Place SmartLine command to draw a 3D line string each end of the bridge deck. When 
drawing the SmartLines, be sure to snap to the ends the lines that were used to make the bridge 
deck surface. 

 
 Select the 3D Smartline and choose the Add to Terrain Model command as shown below. 

 
 When prompted, identify the AllFieldBooks terrain model to add the element. Set the Feature 

Type to the Break Line 
 

 Repeat these steps to add the Smartline at the other end of the bridge deck to the AllFieldBooks 
terrain model 

 
The completed terrain models for the bridge deck and the ground survey are shown below. 
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The bridge deck terrain model is added the Civil Model tab in the Project Explorer dialog as shown 
below: 

 
Notes about this example and data collection procedures 
In this example, the edge of pavement and pavement crown lines for the bridge deck was not collected 
in the field. Instead, 3D lines were drawn across the bridge deck limits in order to generate the surface 
of the bridge deck. This data could have been further enhanced in the field collection process as detailed 
below: 
 

 Use the EP and CP field codes to collect the edge of pavement and center of pavement lines up 
to the bridge deck limits 

 
 Collect the perimeter of the bridge deck using the BD field code, including points at the edge of 

pavement and center of pavement locations. 
 

 Use the LINE2D field code to collect the edge of pavement and center of pavement lines across 
the surface of the bridge deck. The LINE2D code will draw 3D lines in a 3D MicroStation model, 
but the lines are not included in the terrain surface. 
 

 Create the bridge deck terrain model using the 3D lines drawn for the BD and LINE2D features. 
 
The goal is to create a seamless transition from the existing ground terrain model and the bridge deck 
terrain model. There may be other methods to achieve these results. 
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12 Ground Survey and LiDAR Data 

Occasionally it is necessary to merge ground survey information with LiDAR generated terrain models in 
order to deliver a combined terrain model. LiDAR based terrain information can come from a variety of 
sources including the ODOT Office of CADD and Mapping Services and the Ohio Statewide Imagery 
Program (OSIP). Regardless of the data source, the procedure to merge the terrain information is 
similar. This chapter will detail the process to generate an OpenRoads terrain model from OSIP XYZ data 
and merge the data with ground survey information. 
 

Exercise 12 – Merging OSIP Data with Ground Survey 
In this exercise we will merge ground survey information for a slip project with OSIP data for the area. 

Part 1 – Import the Survey Data 

 
 Open MicroStation using the shortcut for the training class 

 
 From the MicroStation File Open dialog, select the Project configuration file TUS-77777 and then 

open the following design file: 
 

\Survey\basemaps\77777_BC001.dgn 
 

 The file was created using the ODOTSeed3d_OH83-NF.dgn seed file. Before proceeding, verify 
that the Ohio North Zone GCS is active. 

 
 Create a new Field Book to import the Survey data. Import the following file: 

 
\Survey\RawData\TUS-77.dc 

 
 After importing the data, create a terrain model for the field book. 

 
There are a few problems with the data that must be corrected before we merge the data with the OSIP 
information. The field code for the Toe of Slope was miscoded as TS instead of TSL. Additionally, there 
are not any mapping codes in the data to define the start and end of the linear features. 
 
Take the following steps to change the TS field code to TSL: 
 

 In the Project Explorer dialog, select the TS point features from the data tree as shown on the 
following page. 
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Once selected, all of the points defined with feature TS are displayed in the Survey Details dialog. 
 

 Open the Survey Details dialog, select all the points, and right-click in the margin to reveal the 
editing options shown below. Change the Feature Definition to TSL and apply the change. 
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 The linking codes for the linear feature have not been defined. In the Survey Details dialog, 
change the Link Code parameter to Start for point SV036 as shown below. 

 
This will dynamically link all the points with the TSL feature definition in numerical order as 
shown below. Next we need to break this up into a few different linear features. 
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 Insert the following Link Codes for the points listed below: 
 

Point Name Link Code 

SV045 End 

SV046 Start 

SV053 End 

SV054 Start 

SV056 End 

SV057 Start 

SV060 End 

SV074 Start 

SV075 End 

 
 All of the Top of Bank features were coded as TB1 in this dataset. These also need to be 

connected using linking codes to define the proper linear features. Make the following edits to 
the Link Code for the TB1 features: 

 

Point Name Link Code 

SV001 Start 

SV014 End 

SV015 Start 

SV024 End 

SV025 Start 

SV035 End 

SV061 Start 

SV073 End 

 
 
Next we’ll review the triangulation of the slip data and remove any unnecessary triangles. 
 

 Change the feature of the terrain model to X_Triangles (select the terrain boundary and choose 
the Properties option to set the Display Feature option). 

 
There are several triangles that connect across areas where no information was collected. This can be 
minimized by setting the Maximum Side Length parameter and then further refined by removing any 
undesired triangles. 
 

 Select the terrain model and choose the Properties option. Change the Edge Method to Max. 
Triangle Length with a Length value of 25. This will remove most of the unnecessary triangles. 

 
 From the Tasks menu, select the Edit Terrain Model command from the Terrain Model tab as 

shown on the following page. 
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The Edit Terrain Model tools shown below are available. These tools are documented in the online help. 
 
 

 
 Use the Delete Edge Triangle command to remove any slivers or undesired triangles from the 

terrain model. When complete, the terrain model should appear similar to the example on the 
following page. 
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Part 2 – Create a Terrain Model from the OSIP data 

OSIP data is available to ODOT employees in XYZ format in the following location: 
 

G:\GEOMEDIA\warehouses\images\osip\lidar 
 
The data is in State Plane coordinates and has been separated into numerous files called “Tiles”. In order 
to determine which tile you need, two design files containing the tile information are available for the 
north and south zones that can be attached to your design file. These files are located in the following 
folder: 
 

\ODOTcadd\Standards\data\OSIPTile_OH83-NF.dgn 
\ODOTcadd\Standards\data\OSIPTile_OH83-SF.dgn 

 
 Attach the North Zone tile file, OSIPTile_OH83-NF.dgn as a reference attachment. 

 
When attaching the reference, be sure to select the Orientation option Geographic – 
Reprojected. 

 
 The tile information is displayed in the file as a series of squares with the tile number. 

 
Make note of the tile number that overlaps the survey area: _______________. 

 
To create a terrain model for the tile, take the following steps: 
 

 From the Terrain Model tab of the Tasks dialog, select the Create Terrain Model From ASCII File 
command. Open the appropriate OSIP .xyz file, using the tile number you located in the previous 
step, from the GEOMEDIA folder. This project is in Tuscarawas County. 
 
Use the following settings in the Create Terrain Model From ASCII File dialog: 
 
Feature Definition   X_Boundary 
Import Options    Import Terrain Only 
Edge Method    Max Triangle Length 
Maximum Side Length   100 
Geographic Coordinate System  OH83-NF 
 
Use the default value for all other settings as shown on the following page. 
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 Select the Create New Text Import Settings File icon which will allow you to define the format 
of the .xyz file that you are importing. The Create Text Import Settings File dialog shown on the 
following page is opened. 
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The dialog contains four tabs on the left: File Format, Columns, Filters, and Options. 
 

 Use the default options on the File Format tab as shown above. 
 

 On the Columns tab, change the settings as follows: 
 
Feature Type  Spot 
Feature Definition X 
 

Change the headings for the columns in the file from Skip to the following: 

Column 1 Easting 
Column 2 Northing 
Column 3 Elevation 

 
 Select the Options tab on the left side of the dialog to set the Geographic Coordinate 

System Source to OH83-NF 
 

 Select the Finish button to save a Text Import Wizard for the process. 
 

From the Create Terrain Model From ASCII File dialog, select the Import command 
button to initiate the process. A terrain model for the selected tile is created. 
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Part 3 – Merging the Terrain Information 

The terrain model for the OSIP tile is much larger than needed. Take the following steps to clip the 
terrain model to include a smaller area: 
 

 Draw a rectangle similar to the one shown below to define the clipping limits. 
 

Note: the Display Feature was changed to Existing Ground Triangles for the OSIP terrain model 
in the example below. 

 
 From the Terrain Model tab in the Tasks dialog, select the Create Clipped Terrain Model icon. 

Use the settings shown below to clip the terrain model. Follow the prompts to select the 
clipping element and initiate the process. 
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A new terrain model for the clipped area is created as shown below in the Project Explorer dialog under 
the Civil Model tab. 

 
 The terrain model for the entire OSIP tile is no longer needed. In the Civil Model tab, right-click 

the n2230205 terrain model and select the Delete option to remove it from the file. The shape 
that was used to define the clipping area can also be deleted. 

 
 To merge the terrain information, select the Create Complex Terrain Model icon from the 

Terrain Model tab in the Tasks menu. The Complex Terrain Model dialog is opened. 

 
Name the new terrain model appropriately for the project using the naming convention specified in the 
ODOT CADD Engineering Standards Manual, Section 305.1. 
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 Using the settings shown above, select the Finish button to initiate the process. 
A rotated view of the merged terrain model is shown below. 

 
Note that the new terrain model, 77777XCB01, is composed from the AllFieldBooks terrain 
model and the n2230205_Clipped terrain model. Even though the n2230205_Clipped model is 
not specifically needed it cannot be deleted from the Civil Model.  
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13 Reports 

The Civil Report Browser is used to generate and print various reports. There are several default reports 
delivered with the software. This section will detail the process to generate a few commonly used 
reports. 
 
This chapter does not contain a specific lab exercise. The following Project and design file, which was 
processed earlier in the training, can be used to test the reports detailed in this chapter: 
 

Project:  LOR-12121 
Design File: \Survey\RawData\12121_FB001.dgn 

 

Generating a Report for a Single Element 
When a point or linear feature is selected, the pop-up menu contains a Report option. In the example 
below, a fence line is selected. 

 
Selecting the Report icon will open the Bentley Civil Report Browser dialog as shown below. 
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Two report formats are available for linear features: SurveyLinearFeature.xsl or 
SurveyLibearfeatureTable.xsl as shown above. 

Civil Report Browser Menu Options 
The Civil Report Browser menu has the following options: 
 

 File 

 Tools 

 Help 
 
The File menu contains the usual commands for opening and saving reports. The Save As… option can 
be used to save the report into an HTML file, an XML file, a DOC file, XLS file or a text file. 
 
Select Tools > Format Options… to open the Format Options dialog shown below. This dialog is used to 
set the precision and format for displaying a variety of types of data in the report. 
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Generating Reports for Multiple Elements 
Multiple elements can be included in a report by selecting the desired element in the Survey tab of the 
Project Explorer dialog, and then accessing the Report command from the Survey Details dialog. 
 
For example, selecting the CNPT feature in the Point Features list as shown below will display data for 
all the point features in the data file that use the CNPT feature code. 
 

 
 
Select the points that you wish to include in the report. Right-click in the selection margin to select the 
Report on selected items option as shown below. The report is shown on the following page. 
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Generating a Control Point Report 

A control point report can be generated with the following steps: 
 

 Select the All Control Points item under the Survey tab in the Project Explorer dialog. 
 

 Open the Survey Details dialog and select all of the control points listed. 
 

 In the Survey Details dialog, right-click in the selection margin and select the Report On selected 
items option. 

 
A report is generated similar to the example below. 
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ODOT Monument Report 
The ODOT CADD Engineering Standards Manual, Section 504.6 Monument Reports, details the 
requirements for a monument report to be included with the digital submission of a project. The 
information in the CADD Manual documents the GEOPAK version of this application which is used to 
generate an ODOT Monument Report from the GPK file for the project. A new application has been 
written to generate a monument report from the OpenRoads Survey information. 
 
The VBA application ODOT_MonumentReport_OpenRoads.mvba can be accessed from the ODOT pull-
down menu in MicroStation by selecting ODOT > Survey > Monument Report (OpenRoads). The dialog 
shown below is opened. 

 
Report File Name: 
This key-in field is used to enter the full path and the name for the report file. The Select button 
may be also be used to specify the path and name for the report file. 
 
The report file naming convention is defined in the ODOT CADD Engineering Standards Manual, 
Section 504.6 Monument Reports. The OpenRoads Survey version of this application does not 
include the functionality to extract station and offset information from a selected chain; 
therefore the chain name shall be omitted from the CSV file name as detailed below. 
 
Monumentation reports shall be stored in the \survey\docs director using the following naming 

convention: 

nnnnn_Monuments.csv 
nnnnn = Five digit PID Number for the project 
 
Example: 12121_Monuments.csv 

 
Generate Report 
Select this button to initiate report generation. The report is an ASCII text file in Comma 
Separated Value (CSV) format. The CSV file generated by this Visual Basic application contains 
the following information: 
 
Point Name, Feature Name, Northing, Easting, Elevation, Geographic Coordinate System 
 
An example of the CSV file, opened in Microsoft Excel is shown on the following page. 
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All of the control points found in all of the Field Books are included in the report. 
 
The feature codes that are considered monuments are defined in the Section 504.6 of the ODOT CADD 
Engineering Standards Manual. These field codes are defined in the Survey Settings in the file 
ODOT_Features_Survey.dgnlib when using the ODOTcadd configuration. To review the list of feature 
codes that are defined in the Survey Settings, take the following steps in MicroStation: 
 

 From the MicroStation Project Explorer dialog select the Civil Standards Tab 
 

 Under the Libraries item, select Project Settings, ODOT_ProjectSettings.dgnlib, Design > Survey > 
Settings. 

 
 Right-Click on Settings and select the Properties option. The Element Information dialog is 

opened containing the settings parameters. 
 

 From the Element Information dialog, select the Points tab. The Control Point Features item 
defines the feature codes to be included as monument points. 
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14 Importing and Exporting Data 

All data generated by the OpenRoads Survey software is stored in the active DGN Model. The existing 
GEOPAK software cannot use the data stored directly in the design file. The necessary data must be 
exported to the appropriate format in order to be used by ODOT’s design personnel. 
 
The following file formats are required for design use: 
 

 GEOPAK Tin Model (.tin) for the existing ground surface 
 

 GEOPAK COGO Database (.gpk) containing the necessary points and linear features 
 
Note that it may not be necessary or even desirable to export all the survey points and linear features 
for topographic features to a GPK file. The designer may only need the control points and any geometric 
centerlines or right-of-way features in the GPK file. In this exercise well export all of the data to the GPK 
file. 
 
Important! 
It is important to remember that any changes made to the survey data after the GPK and TIN models 
have been exported are not dynamically reflected in the GPK and TIN file contents. It is necessary to 
manually export the data to generate new files containing the modifications. This can lead to problems if 
the design personnel have begun to store COGO Chains and Profiles for the proposed work on the 
project. Always coordinate with the design team before updating files. 
 
It is also important to recognize that the position of the survey information is relative to the currently 
selected Geographic Coordinate System. If the data is to be provided to the designer in ground 
coordinates, take the necessary steps to transpose the data to the appropriate coordinate system 
before exporting the data. 
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Exercise 13 - Exporting Survey Points and Chains to a GEOPAK GPK File 
In this exercise, we’ll export the survey points and linear features to a GEOPAK COGO database (.gpk 
file). The GEOPAK Road functions will be used to create the GPK file and access the COGO dialog. This 
can also be done through GEOPAK Survey but to do so would require creating a GEOPAK Survey project 
which is unnecessary for this task. There is less overhead going through the GEOPAK Road menu. 
 

 Open MicroStation using the shortcut for the training class 
 

 From the MicroStation File Open dialog, select the Project configuration file ERI-11311 and then 
open the following design file: 

 
\Survey\RawData\11311_FB001.dgn 

 
 GEOPAK must be active with a GPK file open. 

 
 Before creating a new GPK file, we must select the folder for the GEOPAK Working Directory.  

 
From the MicroStation pull-down menu, select Applications > GEOPAK > Road > User 
Preferences to access the User Preferences dialog shown below. 

 
The Working Directory is used to specify the default location where GEOPAK will save or open 
files. In the ODOT project directory structure, the \geopak folder is used to store the GPK file.  

 
 Set the Working Directory as follows: 

 
\ODOT_Training\OpenRoadsSurvey\ProjectData\ERI\11311\geopak 

 
It is good practice to always review the COGO Preferences before proceeding.  From the 
GEOPAK User Preferences dialog, select the COGO Preferences… option to access the COGO 
Preferences dialog shown on the following page. 
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 Set the dialog as shown above. If there is anything defined in the Job (GPK) Directory be sure to 

remove it or set it to the same value as the Working Directory. 
 

 Select OK to close the COGO Preferences dialog. 
 

 Select OK to close the User Preferences dialog. 
 

 Once GEOPAK is activated and the Working Directory has been set, you can create or open a 
GPK file by selecting Applications > GEOPAK > Road > Geometry > Coordinate Geometry. The 
Coordinate Geometry dialog shown below is opened. 

 
 The Project Name is optional 

 
 Key in the 3-character Job number for the GPK file 

 
 Key in your initials for the Operator Code 

 
 The Subject is optional 
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 Select OK. If the GPK file does not exist, the software will prompt you to create the file. 

 
Select Yes. A file named job###.gpk is created in the current GEOPAK Working directory where ### 
represents the three characters that you have keyed in for the Job. 
 
The Coordinate Geometry dialog shown below is opened. Be sure to set the visualization mode to 
Disable Visualization as shown below. This is necessary to ensure that the coordinate geometry 
software does not visualize the data in the current design file which will result in duplicate graphics for 
the survey information. 
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After the Working Directory has been defined and the GPK file has been created, we are ready to export 
the survey data to the GPK file. 
 

 In the Project Explorer dialog, right click on the desired field book to access the Export To > 
GEOPAK Format option as shown below. 

 

 
 
 

This option is used to export all the survey data in the selected Field Book to the GPK file. The 
software will issue the following warning message. Select Yes to proceed; however, it is not 
recommended that you export all of the topographic information to a GPK file. Typically it is 
desirable only to export specific information to the GPK file such as Control Points. 

 
 To export specific information to the GPK file, select the Point or Linear Features that you wish 

to export in the Survey group of the Project Explorer dialog as shown in the example on the 
following page. 
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 After selecting the desired features, from the Survey 
group in the Tasks menu, choose the Survey Details 
dialog to display the details for the selected items. 
 

 The Survey Details dialog displays the individual 
elements from the selected features. You can 
individually choose which items to export or choose 
them all as shown in the example below. 
 
Right-click in the selection margin to the left of the 
listed elements and choose Export Selected Items > 
GEOPAK Format as shown below. 
 
If any elements exist in the GPK with the same point 
numbers as defined in the survey data, the existing 
elements in the GPK file will be overwritten. The 
software will prompt you whether to write the 
elements to the GPK before completing the export 
process. 
 

 

 
 
Important! 
It is important to follow the standard COGO point naming guidelines specified in Section 306.2 of the 
ODOT CADD Engineering Standards Manual. Also, see Chapter 3 of this training guide for information 
on standard COGO element names. 
 
Important! 
As stated previously, it is important to remember that if changes are made to the survey data a new GPK 
must be exported for design use.  Check with the designers before overwriting any existing GPK file 
information. 
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Exercise 14 - Exporting Terrain Model Data to GEOPAK and LandXML 
 
OpenRoads Survey provides the ability to export the terrain model to the following formats: 
 

 MXRoads 
 Inroads DTM 
 GEOPAK TIN 
 LandXML 

 
The GEOPAK TIN model is required by ODOT’s designers using GEOPAK Road. Occasionally, you may be 
asked by a consultant or contractor to provide a LandXML version of the terrain model that can be 
imported into other software programs. This exercise will cover the steps to export the terrain model in 
both GEOPAK TIN and LandXML formats. 

Exporting the Terrain Model for GEOPAK 

A GEOPAK TIN model must be provided for ODOT’s designers using GEOPAK Road.  
 

 Open MicroStation using the shortcut for the training class 
 

 From the MicroStation File Open dialog, select the Project configuration file ERI-11311 and then 
open the following design file: 

 
\Survey\RawData\11311_FB001.dgn 

 
 Does the designer require the terrain model on the grid, or on the ground? Select the 

appropriate Geographic Coordinate System before exporting the data. Make sure the same GCS 
settings are used for the TIN file export that were used for the GPK export. 

 
 Using the MicroStation Element Selection tool, select the terrain model to reveal the pop-up 

menu shown below. Choose the Export GEOPAK TIN option. 

 
The Export Terrain dialog shown on the following page is opened. 
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 Section 305.1 of the ODOT CADD Engineering Standards Manual defines standard file 

names for GEOPAK TIN files. 
 

 The file should be saved in the \geopak folder for the project as shown above. 
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Exporting a LandXML File 

Take the following steps to export a LandSML file: 
 

 Open MicroStation using the shortcut for the training class 
 

 From the MicroStation File Open dialog, select the Project configuration file ERI-11311 and then 
open the following design file: 

 
\Survey\RawData\11311_FB001.dgn 

 
 Does the client require the terrain model on the grid, or on the ground? Select the appropriate 

Geographic Coordinate System before exporting the data. 
 

 Using the MicroStation Element Selection tool, select the terrain model to reveal the pop-up 
menu with the export options. Choose the Export LandXML option. The Export Terrain Model 
dialog shown below is opened. 

 
 Use the Select Terrain menu to select the terrain model to export. The Project Name, Project 

Description, and Version items are optional. 
 

 The software will step you though each of these key-in fields with floating dialogs on the cursor 
as shown in the example below. Accept each option with a data point. 

 
After stepping through the options, the Export Terrain dialog opens for you to select the folder 
where you would like to save the XML file. By default, the file will be named using the name of 
the terrain model with a .xml file extension. This file should normally be saved in the \geopak 
folder for the project. 
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Exercise 15 - Importing Terrain Models 
Terrain models can be imported from a variety of sources including GEOPAK TIN models and LandXML 
format. In this exercise, we’ll import a GEOPAK TIN model for use with OpenRoads. 
 

 Open MicroStation using the shortcut for the training class 
 

 From the MicroStation File Open dialog, select the Project configuration file DAR-12345 and 
then open the following design file: 

 
\Design\Geopak\basemaps\12345_KD001.dgn 

 
The Task Navigation menu Terrain Model group contains commands to import surfaces from 
anther file, from ASCII files, or from graphics. 

 
 Select the Create from File option to import a surface from another file type. 

 
When the command is selected, the Select Files to Import dialog is opened. The following file 
types are supported: 

 
 Select the GEOPAK TIN (*.tin) option. 
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 Open the following file: 
 

\12345\Design\Geopak\12345_EXGR01.tin 
 
 

The Import Terrain Model(s) dialog shown below is opened. 

 
For this file, make the following settings: 

 
 Set the Source File Units to US Survey Foot 

 
 Set the Feature Definition to Terrain Models > X_Triangles 

 
Note that the Geographic Coordinate Systems can be defined for the Source data. The Target 
data is set to the current design file value. 

 
 After setting the dialog parameters appropriately for the terrain model import, select the 

Import option to initiate the process. The TIN model is imported and the triangles are displayed 
as shown on the following page. 
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The terrain model is not imported as a part of the Survey data. Rather, it is imported as part of the Civil 
Model as shown in the Project Explorer dialog below. 
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15 Media Files 

Media files, such as pictures, sounds, and movies, can be associated with Survey points or Linear 
Features in the OpenRoads Survey data. The media files can be manually attached to the selected 
element, or attached as part of the survey data processing from a dataset that includes photo attributes 
 

Manually Attaching Media Files 
To manually attach a media file, use the MicroStation Element Selection tool to select a survey element. 
Open the Properties dialog as shown below. 

 
The Media Files option is used to attach a media file to the selected point. Choose the … icon to browse 
for the media file. 
 
The Media dialog is opened to which allows you to select media files to associate with the point. 
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Choose the Add button to browse for the media file to attach. 
 
After the file has been attached, a media file icon is displayed on the point in MicroStation as shown in 
the example below. 

 
To review the media attachment, select the Media icon in the Survey Processing task list. 
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You are prompted to select a survey point or linear feature that has a media file attached. When 
selected, the media is opened. In the example below, a jpg image of a mail box was attached to a point 
in the survey data. 
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Processing Datasets with Media Files 
The photos from data collectors with a camera can be attached as a photo attribute to a survey point. 
With the ODOT configuration, Trimble data collectors will prompt the surveyor to take a photo. If the 
data collector does not prompt for a photo, after taking a photo with the data collector the photo can be 
assigned to a specific point. 
 
The example below shows a portion of a .csv file with photo attributes. 

 
By default, the software assumes all photos are in the same folder as the Field Book design file. 
Reviewing the point properties will list the name of the attached Media File as shown below. 
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We have seen cases where the survey processing has failed to attach the images. If this occurs, it may be 
necessary to append the path to the image file in the survey data. In the example below, the .csv file is 
edited to assign a relative path using the Find and Replace command in Excel. The prefix “.\” is added to 
each image file. 

 
For projects with a large number of photos, it may be desirable to save the phots in a sub-directory of 
the RawData folder. In the example below, the photos were stored in a Photos sub-directory. The path is 
prefixed to the image file names in the .csv file as shown below. 
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If edits are made to the .csv file after it was initially processed, it is necessary to delete and re-load the 
data in order to reprocess the changes made to the .csv file. Right-click on the data file and select the 
Delete option as shown below.  

 
After processing the data, survey points with images assigned will be displayed with the Media icon 
similar to the example below. 

 
The Media command is used to view the images as described previously in this chapter. 
 
Note: 
In the SELECTseries 4 release of the software, media files can only be viewed from the original design file 
containing the survey data. Image files are not available from reference attachments or exported design 
files. 
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16 Rotating Survey Symbols 

When survey data is drawn into a MicroStation design file, all of the symbol cells are placed at a zero 
degree rotation. This can often lead to symbols being displayed at odd angles on the construction plans. 
Many users like to rotate the symbols relative to a selected curvilinear element. The 
ODOTcadd_RotateSurveyElements.mvba application can be used for this task. 
 
The application is accessed by selecting ODOT > Survey > Rotate Symbols (OpenRoads). The dialog 
shown below is opened. 

 
Select Reference Element 
Select the element that will be used as the reference 

element that selected cells will be rotated relative to. The 
selected element can be a MicroStation line, linestring, arc, or 
curvestring element. The selected element is displayed as a 
weight 5 line, color 170. 

 
Place Fence Shape 
After the reference element is selected, this command is 

used to place a shape around the elements that you wish to 
rotate relative to the selected reference element. 
 
After the fence shape is placed, the program scans the design file 
for any cells enclosed within the fence shape. The list of cells is 
populated in the dialog as shown in the example on the 
following page. 
 

 
 

The Rotation option is used to select how the cells are rotated relative to the selected reference 
element. The default option, Tangent, is used in most cases. 
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The check list can be used to turn on/off the rotation of selected cells. When the Rotate Selected 
Elements button is selected, the cells within the fence are rotated relative to the selected reference 
element as shown in the example below. 
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17 Existing Utilities and Storm Sewers 

For OpenRoads corridor modeling, ODOT’s design personnel will require the existing storm sewer and 
other utility information in a 3D model. An example of a 3D catch basin is shown below. 
 

 
Not every project will be developed using a 3D model. For projects that do not require a model, the 
legacy GEOPAK tools, and ODOT’s VBA applications for existing storm sewers, are used to show the 
storm sewer information on the plan, profile, and cross sections. 
 
This chapter documents the workflow to provide survey information using the following processes: 
 

 The legacy process, using ODOT’s Drainage VBA Applications, is used for projects that do not 
require a 3D model. This process uses ODOT’s legacy field codes for the drainage structures. 
Attributes assigned to the survey points for each drainage structure that define the pipes 
terminating within each structure. A GEOPAK GPK file is required for this process. Survey data 
processed with OpenRoads Survey tools can be used for this workflow as detailed in this 
chapter. 
 

 The second workflow uses a new set of field codes for the drainage structures. The new process 
does not require attributes for the pipe information, nor does it require a GEOPAK GPK file. 

 
The Surveyor should review this chapter with the design personnel before beginning the field survey to 
determining which method is required. 
 



October 25, 
2016 

GEOPAK Survey with OpenRoads Technology  

 

Page 194 Chapter 17 –Existing Utilities and Storm Sewers 

 

Using OpenRoads Survey Data with the Legacy ODOT VBA Applications 
If the design personnel for the project will use the legacy ODOT VBA Applications to draw the storm 
sewer information on the plan, profile, and cross sections, the legacy process to assign attributes to the 
catch basins, manholes, and inlets is documented in the following PDF file: 

..\ODOTcadd\Standards\vba\Doc\ODOT_DrainageVBA.pdf 

 
The legacy field codes using the drainage attributes are required for this process. When the data is 
collected using the drainage attributes documented in the above PDF file, the pipe information for the 
drainage field codes can be reviewed using the Project Explorer and the Survey Details dialog. In the 
example below, the point feature PIO is selected in the Survey group of the Project Explorer dialog. All of 
the points in the Field Book with the PIO field code are displayed in the Survey Details dialog. 

 
The Description column lists the attributes for each surveyed PIO point. In the example above, note that 
OpenRoads uses a colon character for the separator between the attribute name P1 and the attribute 
value. The ODOT VBA applications assume an equal sign is used to separate the attribute name from the 
value. 
 
The ODOT VBA applications read the surveyed drainage information from a GEOPAK GPK file. The 
drainage points must be exported to a GPK file as detailed in chapter 14 of this training guide. 
 
Once the points have been saved in the GPK file, the GEOPAK COGO Navigator can be used to review 
the points as shown on the following page. 
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Before the data can be used with the legacy ODOT Storm Sewer VBA applications, the format of the 
description must be changed to replace the colon with an equal sign. Select ODOT > Hydraulics > 
Existing > Plan View – Attribute Checker to run the ODOT_EXDrainageAttributeChecker.mvba 
application that is used to review and edit the attributes. 
 
When the Run Check button is selected, the application will replace the colon character with the equal 
character as well as check each point to ensure that the attribute format is correct. In the example 
below, three points were found that do not have the proper format. The attribute checker is used to 
enter the correct value and update the point description in the GPK file. 
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Note that the attribute checker may not catch all errors. After editing the attributes, review the point 
description in the Navigator dialog to ensure that there are not any other errors. In the example below, 
the Description for point SV2313 will be edited in the Navigator dialog to remove the (36”X60”) text at 
the surveyor appended to the end of the P1 attribute, which is not needed (as shown on the previous 
page), to correct the entry for the culvert size which should be entered in rise by span format as 36X60. 

 
Notes: 
 

 Editing must be enabled by selecting Tools > Settings from the Navigator dialog, and then 
checking on the Single Click Enables List Cell Editing option. 
 

 The Redefine option must be toggled on in the main COGO window to allow editing. 
 

 This section assumes knowledge of the GEOPAK COGO functions. See the online help of ODOT’s 
GEOPAK Road 1 training guide for information not covered here. 
 

 The cells placed by the legacy field codes can be used to extract a 3D utility model using the 
processes detained in the following sections. 
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Using OpenRoads Survey Data to Generate a 3D Model 
This section documents the field surveying process to collect the storm sewer information in a format 
suitable to generate the 3D model. The process described here replaces the process described in the 
previous section using the drainage attributes. 
 
ODOT’s previous procedure relied on the storm sewer points being stored in a GEOPAK GPK file. Since 
the survey points are no longer stored in a GPK file, and the GPK file will be removed from the 
OpenRoads software in a future release, a new process is necessary. 
 

 For OpenRoads projects using a 3D model, ODOT will no longer use the attributes P1, P2, P3, P4, 
and P5 to store the storm sewer pipe information with the survey points. These attributes are 
still in the feature definition library, but will most likely be removed at a future date. 
 

 ODOT’s VBA applications for drafting the existing storm sewer pipes will eventually be retired 
and replaced by the process documented in this section. 
 

 New field codes, which were previously defined in the “Office Use” category of ODOT’s GEOPAK 
Survey Manager Database file (ODOT.smd) will be added the code list in the data collectors. 
These field codes are used to more accurately represent the actual drainage structure types. 

 
The recommended process for the data collection of existing storm sewer information for OpenRoads 
3D modeling is summarized below: 
 

 Shoot the storm sewer structures using the new ODOT field codes for drainage items. 
 

 Shoot the invert of the drainage structure using the FLINE field code. If you are unable to shoot 
the invert, measure the depth and take a shot on the grate adding the depth to the rod height. 
 

 Pipe information will be recorded in a Microsoft Excel file in the format defined in this training 
manual. The pipe information contained in the Excel file can be collected at the time each 
drainage structure is surveyed, or at a later date. 
 

 Rotate the cells placed by OpenRoads Survey to represent the actual position of the drainage 
structures. The ODOT VBA Application ODOTcadd_RotateSurveyElements.mvba is used for this 
purpose. 
 

 A new ODOT VBA application, ODOTcadd_ExistingStormSewer.mvba, will be used to read the 
drainage pipe information from a CSV file to draw the pipes in the 3D survey Field Book design 
file. 
 

 The 3D model for the drainage network can be generated by either the surveyor or the designer. 
Bentley’s Subsurface Utility (SUDA) software is used to generate the 3D model of the drainage 
information. This 3D model of the storm sewers will be generated in a separate drainage 
basemap design file contained in the design\Roadway\Basemaps folder. The file is named using 
the “BD” file name code. 
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Field Codes for 3D Modeling 

ODOT’s field code list provides field codes for various storm sewer catch basins, manholes, and inlets. 
The complete code list can in PDF format can be found in the ODOTcadd Standards in the following 
folder: 

..\ODOTcadd\Standards\GEOPAK\Survey\Field_Codes\ 

 
ODOT has traditionally used generic field codes for the data collection of storm and sanitary structures. 
As ODOT continues to move towards and increased use of 3D modeling, it will become increasingly more 
important to generate models with storm sewer information that more accurately represents the size 
and location of the drainage structures found in the field. 
 
The generic field codes are supplemented with specific codes that can be used to change the field code 
on specific survey points in order to draw a catch basin, inlet, or manhole type that more accurately 
represents the actual structure in the field.  The supplementary codes for specific structure types have 
not been included in the data collector code list up to this point. These codes are defined in the GEOPAK 
Survey SMD file, and also in the OpenRoads Survey feature definition library. The available features can 
be reviewed in the Project Explorer dialog by accessing the Civil Standards group as shown below. 

 
 
The Catch Basins, Inlets, and 
Manholes categories contain the 
supplemental codes. 
 
The legacy generic codes are 
contained in the Structures - Generic 
category. 
 
The Pipes - Generic category contains 
the legacy drainage pipe codes that 
should no longer be used. All pipe 
information should be collected using 
the procedures documented in this 
chapter. 
 
The name of the actual field code is 
prefixed with “Survey_” in the feature 
definition library as shown at left. 
 
The specific feature types for catch 
basins, inlets, and manholes can be 
used after the data has been 
processed to edit a specific survey 
point and change its feature definition 
in order to draw the appropriate plan 
view cell. 
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To change the feature definition for a survey point to one of the specific field codes, select the point and 
choose the Properties icon. Key in the new Feature Definition name, omitting the “Survey_” prefix. 

 
 

The generic field code CBS was 
used in the field for this survey 
point. The point is drawn using 
the cell for a No. 2-2B catch 
basin. The available catch basin 
field codes can be reviewed in 
the Project Explorer dialog In 
the Civil Standards group as 
shown on the previous page. 
The CB-2 category is shown 
below. 

 
Changing the code to CB-2-5 results in the appropriate plan view cell being drawn for the structure as 
shown below. 
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As ODOT moves into 3D modeling, the generic field codes will be replaced with field codes representing 
the basic catch basin, inlet, and manhole types. The following table summarizes the codes that should 
be used in place of the generic codes: 
 

New Code Old Code Description 

CB-2-2B CBS Catch Basin No. 2-2B 
Use the code for catch basin No. 2-2A, 2-2B, 2-3, 2-4, 2-5, and 2-6 

CB-3 CI Catch Basin No. 3 
Use the code for catch basin No. 3 and 3A 

CB-4  Catch Basin No. 4 
Use the code for catch basin No. 4 and 4A 

CB-5  Catch Basin No. 5 
Use this code for catch basin No. 5, 5A, 8, and 8A. 

CB-6  Catch Basin No. 6 

CB-7 CBR Catch Basin No. 7 

I-2-6  Median Inlet No. 2-6 
Use this code for all No. 2 and 2A inlets 

I-3B MI Median Inlet No. 3 

I-4B  Median Inlet No. 4 

MH-3 STMH This code places a cell for a Manhole No. 3 but should be used for 
all storm sewer manholes 

MH-3-SAN SSMH Manhole No. 3 
Use this code for all sanitary sewer manholes 

 
While the new codes listed above are more specific than the old field codes, they are still somewhat 
generic as they do not take into account the size of the vault for each structure type. 
 
The following two codes are provided for the flow line at the top and bottom of drainage structures. 
 

Code Description 

FLINE Flow line at the bottom of the drainage structure 

FLTOP Low point elevation of the inlet or catch basin grate/top. 

 
Further instructions for editing the code for each of the above field codes are provided in the following 
pages. 
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Code Description Plan View Cell 3D View 

CB-2-2B Catch Basin No. 2-2B 
 
Use this code for all 
square catch basins 
with a note designating 
the size of the vault 
and whether the 
structure has a side 
inlet. 
 

CB22B-X 

 

 

Notes: 
Shoot the center of the grate. 
 
Edit the field code in the office to use one of the other square catch basin types: 

 CB-2-2A 

 CB-2-3, CB-2-3SI 

 CB-2-4, CB-2-4SI 

 CB-2-5, CB-2-5SI 

 CB-2-6, CB-2-6SI 

 

Code Description Plan View Cell 3D View 

CB-3 Curb Inlet No. 3. 
 
Also used for No. 3A 
which has one grate. 

CB3-X 

 
 

 

Notes: 
Shoot the low spot of the grate, at the face of curb in the center of the structure. 
 
Edit the field code in the office to use one of the other types: 

 CB-3A 
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Code Description Plan View Cell 3D View 

CB-4 Catch Basin No. 4 
 
Use this code for catch 
basin No. 4 and 4A. 
The vault size varies 
for the 4A structures. 

CB4-X 

 

 
Notes: 
Shoot the center of the grate. If the grate is slanted, take a second shot at the low point using the FLTOP 
field code. 
 
Edit the field code in the office to use one of the CB4A types: 

 CB-4A-42, CB-4A-48, CB-4A-54, CB-4A-60, CB-4A-66, CB-4A-72  

 

Code Description Plan View Cell 3D View 

CB-5 Catch Basin No. 5 
 
Use this code for catch 
basin No. 5, 5A, 8, and 
8A. The vault size 
varies for the 5A and 
8A structures. The 8 
and 8A structures have 
a v-shaped grate. 

CB5-X 

 

 

Notes: 
Shoot the center of the grate. If the grate is slanted, take a second shot at the low point using the FLTOP 
field code. 
 
Edit the field code in the office to use one of the CB-5A or CB-8A types: 

 CB-5A-42, CB-5A-48, CB-5A-54, CB-5A-60, CB-5A-66, CB-5A-72 

 CB-8A-42, CB-8A-48, CB-8A-54, CB-8A-60, CB-8A-66, CB-8A-72 
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Code Description Plan View Cell 3D View 

CB-6 Catch Basin No. 6 CB6-X 

 

 

Notes: 
Shoot the back of the grate. 

 

Code Description Plan View Cell 3D View 

CB-7 Catch Basin No. 7 CB7-X 

 

 

Notes: 
Shoot the center of the grate. For domed grates, add the height of the dome (approximately 4”) to the 
rod height. A flat grate is used for the 3D model. 
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Code Description Plan View Cell 3D View 

FLINE Flow line at the bottom 
of the drainage 
structure 

GTM 

 

NA 

 

Code Description Plan View Cell 3D View 

FLTOP Low point elevation of 
the inlet or catch basin 
grate/top. 

GTM 

 

NA 

 

Code Description Plan View Cell 3D View 

I-2-6 Median Inlet No. 2 I26-X 

 

 

Notes: 
Shoot the flow line elevation at the center of the opening. These inlets come in various sizes from 6’ to 
20’ in length, in 2’ increments. 
 
I-2 median cells are 3.0’ wide.  I-2A median cells are 3’-4” wide. 
 
Edit the field code in the office to use one of the I-2 or I-2A types: 

 1-2-6, 1-2-8, 1-2-10, 1-2-12, 1-2-14, 1-2-16, 1-2-18, 1-2-20 

 1-2A-6, 1-2A-8, 1-2A-10, 1-2A-12, 1-2A-14, 1-2A-16, 1-2A-18, 1-2A-20 
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Code Description Plan View Cell 3D View 

I-3B Median Inlet No. 3 I-3B-SS-X 

 

 

Notes: 
Shoot the center of the grate. 

 

Code Description Plan View Cell 3D View 

I-4B Median Inlet No. 4 I-4B-SS-X 

 

 

Notes: 
Shoot the approximate center of the structure on top of the barrier. Measure the barrier height and add 
that value to the rod height to set the elevation for the grate. 
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Code Description Plan View Cell 3D View 

MH-3 Storm Manhole 
 
Use this code for all 
storm sewer manhole 
types. 

MH3-48D-X 

 

 

Notes: 
Shoot the center of the lid. 
 
The plan view cell origin is at the center of the base, not at the center of the lid. As a result, the manhole 
position will be shifted in relation to the survey shot at the center of the lid. The bigger the vault, the 
more the shift. Take a second shot at the approximate center of the base on the surface of the ground. 
Code this shot using the X2D feature code with a note to designate this as the actual center of the 
structure. In the office, edit the survey point to use the Northing and Easting coordinate of the X2D shot 
with the elevation from the shot on the lid. 
 
Edit the field code in the office to change the manhole type appropriately 

 MH-1 

 MH-2-12, etc… 

 MH-3-48, etc... 

 MH-4-72, etc… 

 MH-5-30, etc… 
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Code Description Plan View Cell 3D View 

MH-3-
SAN 

Sanitary Manhole MH1D-X-SAN 

 

 

Notes: 
Shoot the center of the lid. 
 
The plan view cell origin is at the center of the base, not at the center of the lid. As a result, the manhole 
position will be shifted in relation to the survey shot at the center of the lid. The bigger the vault, the 
more the shift. Take a second shot at the approximate center of the base on the surface of the ground. 
Code this shot using the X2D feature code with a note to designate this as the actual center of the 
structure. In the office, edit the survey point to use the Northing and Easting coordinate of the X2D shot 
with the elevation from the shot on the lid. 
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Field Codes for Storm Sewer Pipes 

The ODOT field code list provides several legacy field codes for various pipe types. The pipe material will 
be defined in the Excel file with the drainage pipe information, therefore it is not necessary to code the 
pipes with a specific field code for the pipe material. These legacy codes are retained in the data 
collector list, but are no longer required and may be removed at a future date. 
 
The following field codes are typically used for all drainage pipes, drive pipes, and culverts on a typical 
ODOT survey: 
 

Code Description Plan View Cell 3D View 

CULV Flow line at each end 
of a box culvert.  

GTM 

 

 
Notes: 
Shoot a point at each end of the culvert. Note the span and rise of the interior of the box. 
 
Use the Visual Basic program ODOTcadd_ExistingStormSewer.mvba to draw box culverts between two 
OpenRoads survey points 

 
 

Code Description Plan View Cell 3D View 

FDO For Direction Only 
 
Used to show the 
direction of a pipe 
when the other end 
cannot be located 

GTM 

 

NA 

PIO Pipe Inlet/Outlet. 
 
Shoot the invert of the 
pipe 

GTM 

 

NA 

 
For open pipes and box culverts, it is not necessary to collect the pipes as linear features by use of the 
BL* and EL* mapping codes. For example, both ends of an open pipe should be collected using the PIO 
field code and later connected using an ODOT visual basic application. 
 
It is not necessary to shoot the pipes in a drainage structure. These will be drawn using a CSV file 
containing the pipe information and an ODOT Visual Basic application. 
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Field Collecting Drainage Pipe Information 

The pipes will be drawn using a custom VBA application with the drainage pipe information contained in 
a CSV file. The pipe can be field collected as the drainage structures are surveyed, or collected at a later 
date. In either case, it is necessary to define the pipe information in a CSV file for processing with the 
VBA application. 
 
ODOT provides a template Excel file used to collect the pipe information. The template Excel files is 
located in the ODOTcadd Standards. 

..\ODOTcadd\Standards\Geopak\Survey\ODOT_ExistingStormSewers.xlsx 

 
Note that the data must be exported from the Excel file to a CSV file for processing. Custom Excel files 
can also be used as long as the required information is saved to a CSV file using the format documented 
below. The first few lines of an example CSV file are shown below: 

 
The First Point and Second point values can be a drainage structure, and PIO, or an FDO point. Pipes can 
be drawn from drainage structure to drainage structure, from pipe end to pipe end (two PIO points), or 
from a drainage structure to a PIO or FDO point. 
 
The order of the fields is fixed and cannot be modified. Each field is described below: 
 

Field Description 
First Point Name The point name for the drainage structure, PIO, or FDO point 

Depth or Elevation The measured depth to the pipe invert, or the actual elevation of the pipe invert. 
 
Notes: 

- If the value is greater than 200 it is assumed to be an elevation 
- Values less than 200 are subtracted from the First Point elevation when the 

CSV file is processed 
- Use a value of 0 for PIO and FDO points 

Size The pipe size, in inches 
- Use numbers only, do not append a double quote character to designate 

inches 
- Elliptical pipes are entered in rise by span format without any spaces or other 

characters. Example: 14x23 

Material The pipe material. Use only the abbreviations defined in the ODOT Excel file 

Second Point Name The point name for the other end of the pipe, a structure, PIO, or FDO point 

Depth or Elevation The measured depth to the pipe invert, or the actual elevation of the pipe invert. Notes: 
- If the value is greater than 200 it is assumed to be an elevation 
- Values less than 200 are subtracted from the First Point elevation when the 

CSV file is processed 
- Use a value of 0 for PIO and FDO points 
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Processing Pipes with ODOTcadd_ExistingStormSewer.mvba 

The MicroStation Visual Basic program ODOTcadd_ExistingStormSewer.mvba is used to draw drainage 
pipes and box culverts between two OpenRoads survey points. The application has two modes: 
 

 CSV Input 
 Manual Input 

 
The application is accessed from the ODOT pull-
down menu by selecting ODOT > Survey > Existing 
Pipes (OpenRoads). When the program is selected, 
the dialog shown at right is opened. 
 
This CSV Input and Manual Input modes are used in 
the survey Field Book (FB) design file to draw pipes 
and culverts between drainage structures, PIO 
shots, and FDO shots. 
 
Box culverts are placed using the Subsurface 
Utilities software functions as described later in this 
document.  
 
The operation of each mode is described below. 
 
CSV Input 
This mode is used to read a CSV file containing existing pipe information and draw storm sewer and 
sanitary sewer pipes and culverts into the survey field book design file. The lines that are drawn for the 
pipes are drawn in 3D at the correct elevations, however these lines are just “flat” lines using the ODOT 
line style for drainage pipes. 
 
The lines for the pipes are drawn between a pair of OpenRoads survey points by reading a CSV File 
containing the pipe information. The format of the CSV file is defined in the previous section. The 
application requires a 3D model. 
 
Select the CSV file and the Field Book. Choose the Process File option to initiate processing. An example 
of the plan graphics for the pipes drawn in the field book design file is shown below. 
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The pipe labels and flow arrows are placed using the active annotation scale and the active MicroStation 
text style. Changing the annotation scale after the CSV file has been processed will scale the text size, 
but not the flow arrow. 
 
In addition to the size and type, the elevation at each end of the pipe is plotted for information on the 
level SC_Scratch1 as shown in the example below. 

 
As the CSV file is processed, the selected field book is searched for survey points matching the point 
names defined in the CSV file. If a point in the CSV file is not found in the selected field book, it is 
reported in a separate dialog as shown in the example below. 
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CSV Input Notes: 
The graphics drawn by the VBA application are drawn at the actual elevations defined by the 
CSV file processing. 
 
The graphics in the survey basemap design file are intended for plan production purposes, not 
for 3D modeling. The 3D pipe information can be extracted from these graphics to generate a 
3D model of the drainage features as described later in this document. 

 
 
Manual Input 
Manual input mode is used to enter the information for pipes and culverts, one at a time. This mode is 
useful for projects with only a few pipes when a CSV file will not be used. 
 
The Point 1 and Point 2 fields are used to enter 
the name of the points that will be used to 
draw a pipe or culvert. The point names must 
be contained in the selected Field Book. 
 
When a point name is entered, the feature 
name and elevation of the point is reported in 
the Feature and Elev fields. 
 
The Dip fields are used to enter the depth for 
the pipe or culvert at the Point 1 and Point 2 
location. 
 
Like the CSV mode, the graphics drawn are 
placed at the computed elevation for the end 
points of the pipe, however the graphics are “flat” 
lines intended for plan sheets. These lines can use used to extract 3D pipes as described later in this 
document. 
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Drainage Basemap Design Files 

The 3D model of the existing drainage information is typically generated in a separate drainage 
basemap. The drainage basemap is created using the ODOT_Files.mvba application. The survey data is 
referenced to the drainage basemap. The drainage structures and the pipes are extracted from the 
survey file using the Subsurface Utility commands to generate the 3D model. 
 
Use the ODOT_Files.mvba application to create a new drainage basemap for the 3D model. 
 
From the MicroStation pull-down menu, select ODOT > File Management > Create Design Files to 
access the program as shown below. 

 
Notes: 

 Use the 2D seed file to create the drainage basemap. The Subsurface Utilities software will 
generate a separate 3D model in the drainage basemap design file for the 3D drainage 
information 
 

 The file is created in the roadway\basemaps folder 
 

 The two-character file code is “BD”. 
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Extracting the 3D Drainage Nodes 

Bentley’s Subsurface Utility tools are used to generate the 3D model of the existing drainage 
information. Catch basins, manholes, and inlets are referred to as a “node” by the subsurface utility 
software. 
 
Take the following actions to create a 3D model of the existing drainage information. It is assumed the 
catch basin, manhole, and inlet cells have been rotated into place in the survey basemap before starting 
this process. 

 
1. Open the newly created drainage basemap design file. 

 
2. Attach the survey basemap as a reference. 

 
3. From the MicroStation Tasks menu, select the Extract Utilities from Graphics command as 

shown below. 
 

Note: 
If this is the first time you have 
selected the command, you are 
prompted to create a utility model. 
Select Yes to create the utility 
model. 

 
After the utility model is created, 
you must select the icon again to 
access the Extract Utilities from 
Graphics dialog shown below. 

 
4. Set the Method to Utility Filter. Several filters 

are provided in the ODOTcadd Standards for 
individual drainage items as well as groups of 
items. 
 

5. Use the Select Filter item to choose All Catch 
Basins filter. This filter is configured to extract 
only the drainage cells for the catch basins and 
not the pipes. The pipes will be extracted 
individually as a separate process. 
 

6. Toggle on the Use 3D Element Elevations 
option. 
 
The Design Stage item is not relevant. 
 
The options can also be selected by use of the 
menu prompts floating on the cursor. 
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7. Accept the options as you are prompted on the cursor to initiate the extraction process. 
 

The 3D drainage structures are extracted using the elevation of the cells mapped by the Survey process. 
As each drainage structure is processed, the extraction process will search for a FLINE feature to 
establish the depth of the drainage structure. If a FLINE feature is not found, the depth is set using at a 
default value. 
 
If the drainage basemap was created with a 2D seed file, which is the recommended best practice, the 
Extract Utilities from Graphics process will create a new model named Design-3D containing the 3D 
drainage structures. This new model is automatically attached as a reference to the current 2D model. 
 
In addition to the 3D model, a 2D graphic is placed in the current 2D model for each extracted drainage 
structure nodes. This graphic is linked to the 3D model and can be used to make edits to the drainage 
structure. 
 
In the example below, the reference file display of the survey basemap and the Design-3D model has 
been turned off to show the 2D graphic that is placed for one of the drainage structures. 

 

 
Selecting the graphic reveals a pop-up menu that 
can be used to make edits to the drainage structure 
as well as two rules (Node Top Elevation, and Node 
Rotation) that can be edited by selecting the 
displayed text. 
 
The extracted drainage structures do not take into 
account the rotation angle of the original cells and 
are placed at a zero degree rotation. The example 
at left below shows the original cell as referenced 
from the Survey basemap, and the 2D cell that was 
placed as part of the utility extraction process. It is 
necessary to rotate each structure manually. 
 
Once the 2D node is selected, parameters for the 
rotation of the 3D structure are displayed as shown 
at left. The angle can be keyed-in by selecting the 
angle text, or the 3D structure can be rotated by 
selecting one of the rotation arrows.  
 
Typically, it is best to get the rotation angle of the 
original cell and use that value to key-in the 
rotation angle for the drainage node as described 
on the following page. 
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Take the following steps to key-in the rotation angle for the drainage structure: 
 

 Change the Angle Readout as shown below by selecting Settings > Design File from the 
MicroStation pull-down menu. 

 
 Use the MicroStation Element Information command to get the rotation angle of the original 

cell as shown below. 
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 Select the drainage node graphic and choose the Properties command from the pop-up menu. 
The Rotation can be modified as shown below. The graphics for the node in the 3D model are 
updated as changes are made to the properties. 

 
 
After extracting the drainage structures and rotating them into place we are ready to extract the pipes.  
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Extracting Drainage Links 

The Extract Utilities from Graphics command can be used to extract pipe information; however, as of 
this writing the current release of the software will not connect the extracted pipes to the previously 
extracted nodes. Even though it is more cumbersome, with the current software, it is better to place 
each pipe manually as a “link” using the Connect Conduit Link Between Nodes command, shown below. 

 
The dialog shown below is opened. 

 
General information for the command can be found by 
selecting Subsurface Utility > Help > Subsurface 
Utilities Help from the MicroStation pull-down menu. 
 
The Feature Definition is used to select the pipe type. 
 
The Description item is used to select the pipe size.  
 
The Name Prefix is used to name each pipe and is 
incremented as you extract the pipes. 
 
When the command is selected, you are prompted to 
Select Start Node. 

 
 
The ODOT 3D drainage items have specific connection regions on each side of rectangular structures. 
Circular structures have a circular connection region. When the first node is selected, the link starts from 
one of the connection regions. Follow the prompts to select the second node. An example is shown on 
the following page. 
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A line is placed in the current 3D model that can be used to modify he link. The extruded 3D link is 
placed in the 3D model as shown below. 

 
The link is placed at the lowest elevation of the selected nodes. The elevation values can be edited by 
selecting the link in either the 2D or the 3D model, and then choosing the Properties icon from the pop-
up menu. 

 
From the Properties menu, shown at left, the Start 
Invert and Stop Invert values can be edited if 
necessary to set the correct elevations for the pipe. 
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Connecting Links to a FDO or PIO Point 

The field codes PIO and FDO can both be used to designate the end of a pipe. PIO is used to designate an 
inlet or outlet point for an open pipe of culvert. FDO (for direction only), is used to designate the 
direction of a pipe when the other end cannot be located. 
 
There must be a node defined at the PIO and FDO locations in order to place a link in the design file 
using the PIO and FDO points. The Extract Utilities From Graphics command is used to extract nodes at 
the PIO and FDO locations,  

 
The command is selected from the task 
menu as shown at left. 
 
 
 
 
 
 
 
 
 

 
Take the following steps to extract nodes for the 
PIO and FDO points: 
 

 Set the Method to the Utility Filter 
option. 

 

 Use the Select Filter option to choose 
the PIO/FDO filter. 

 

 Toggle on the Use 3D Element 
Elevations option. 
 

 Accept these options as prompted. 
 
 
The extracted node for the PIO and FDO points is 
placed as a triangle at each point on the level 
SC_Scratch1 as shown at right. 
 
The Connect Conduit Between Nodes 
command described in the previous 
section is used to place the pipes between 
the nodes. 
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Extracting Multiple Links 

Multiple pipes of the same type and size can be extracted simultaneously using the Extract Utilities 
From Graphics command. This method has one advantage over placing each link manually using the 
Connect Conduit Between Nodes command. When the pipes are extracted, the actual 3D elevations of 
the graphics can be used for the created links. The Connect Conduit Between Nodes command uses the 
flow elevation for the structure as the default elevation for newly placed links. However, there is one 
significant disadvantage that prevents us from recommending this command. The extracted links are not 
connected to the previously extracted nodes. New nodes are placed at each end of the pipe using a 
default symbol. Since new nodes are created, this method is not the preferred method to generate the 
links. 
 
ODOT has submitted several change requests to Bentley in relation to the utility extraction process. 
While not recommended at this time, this procedure is documented here for future reference. 
 
To extract multiple links from the pipe graphics, select the Extract Utilities from Graphics command. 

 
The dialog shown below is opened. 

 
 Set the Method to Selection to select the surveyed pipe lines to extract. 
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 The Create Trench and Design Stage items are not relevant. 
 Set the appropriate Feature Definition for the type of pipe that you will be extracting. 

 
 The Name Prefix is used to name each pipe and is incremented as you extract the pipes. 

 
 The Description field is used to select the size of the pipe 

 
 Issue a data point to accept the Select Method prompt. You are prompted to Locate Elements – 

Reset to Complete for the pipe extraction process. 
 

 Choose all of the pipe elements that are the same type and size corresponding to the Feature 
Definition and Description that you have selected in the Extract Utilities from Graphics dialog. 
 

 After you have selected all of the desired pipe elements, issue a Reset to complete the selection 
process. 
 

 As you step through the process, you are prompted as follows: 
o Use 3D Element Elevations? Select Yes. 
o Create Trench. Select No 

 
As each pipe is extracted, a 3D Node is placed on the level Default at the end of each pipe as 
shown below. This 3D block is required and must not be deleted. Turn off the level Default to 
turn off the display of these nodes. 

 
As stated previously, this method is not the preferred method since new nodes are placed at the ends of 
the pipes. 
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Reviewing and Editing Nodes and Links 

After the nodes and links have been created, it is good practice to review the values for accuracy. The 
parameters of the 3D drainage information can be edited by using the MicroStation Element Selection 
tool to select a node or link, and then choosing the Properties icon from the pop-up menu as shown 
below. 

 
The parameters are shown below. Note that the invert values for a link cannot be edited if the link was 
extracted from graphics. 
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Link Properties Node Properties 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 GEOPAK Survey with OpenRoads Technology 
October 25, 

2016 
 

Chapter 17 – Existing Utilities and Storm Sewers Page 225 

 

Box Culverts 

The graphics for existing storm water utilities are normally placed in a 2D model in the drainage (BD) 
basemap design file. The Subsurface Utility software is used to place the box culvert in a 2D model. The 
software will automatically generate the 3D model for the box culvert. 
 
After creating a drainage basemap design file, attach the survey basemap as a reference file in order to 
view the culvert shots. Box culverts are surveyed using the CULV field code to take a shot at the invert 
elevation at each end of the culvert. 
 
Box culverts are placed as a link by the Subsurface Utility software by use of the Connect Conduit 
Between Nodes command. A node must first be placed at each end of the proposed box culvert in the 
design file by use of the Place Node command. The generic headwall feature definition is used to defile 
the location of each end of the box culvert.  
 
Select the Place Node command from the task list as shown below. 

 

 
 
 
 
Place a node at each end of the proposed box culvert using the Generic Headwall-X feature definition as 
shown above. 
 
The user is prompted to select a reference element for the node elevation as shown below.  

 
Nodes can be placed at a specific elevation, or relative to 
the selected surface or a corridor model. Issue a Reset to 
type an elevation. 
 

 
 
 



October 25, 
2016 

GEOPAK Survey with OpenRoads Technology  

 

Page 226 Chapter 17 –Existing Utilities and Storm Sewers 

 

After the elevation reference is defined, the user is prompted to set the Placement Type. 
 
The By Minimum Depth option is used to set the initial depth using a default value. The invert elevation 
can be edited after placement if necessary. 
 
 
 
Next the user is prompted to set the location 
of the node. Place the node at the location of 
the CULV survey point. 
 
The generic headwall node is placed using a triangle symbol on the 
level SC_Scratch1 as shown at right. The direction of the triangle, 
defined by the Rotation parameter, is irrelevant to the flow direction 
of any links connected to the node. 
 
After the headwall points have been placed at each end of the culvert, 
the box culvert is placed using the Connect Conduit Between Nodes 
command shown below. 
 

 

 
 
 
Feature definitions for existing and proposed box culverts are provided in the ODOT standards. The 
available features for existing box culverts are shown on the following page. The span and rise for each 
available culvert feature is defined by the Description field as shown at right above. 
 
Available culvert sizes are based on the Figure 1008-14 of the ODOT Location and Design Manual – 
Volume 2, Drainage Design. 
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The culvert is placed by selecting each node as shown below. 
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Two sets of graphics are drawn for the box culvert as shown below. 
 

The culvert is drawn as a 
custom line style in the 2D 
model as shown at left. The 2D 
model can be referenced back 
to the survey basemap (BE file) 
if desired, or attached as a 
reference by the design 
personnel. 
 
 
 
 
 
 
 
 
 
 
 
 

 
The Subsurface Utility software also creates a 3D model in the drainage basemap named “design-3d” 
containing the 3D model of the box culvert as shown below. 

 
 
 
 
 


